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1.1 Latar Belakang 

BABI 
PENDAHULUAN 

Daerah Irigasi Jatiluhur yang mencakup luas areal 240.000 ha, tersebar dalam'"beberapa 

kabupaten yaitu Purwakarta, Subang, Karawang, Bekasi dan Indramayu; mendapat air dari 

Waduk Jatiluhur di Sungai Citarum melalui Bendung Curug dengan Saluran Induk Tarum 

Timur dan Tarum Barat serta Bendut\g Walahar melalui Saluran Induk Tarum Utara. Daerah 

Irigasi Jatiluhur ini merupakan lumbung padi Jawa Barat yang selama 30 tahun terakhir 

telah memberikan sumbangan yang sangat besar terhadap upaya pemerintah untuk 

memenuhi kebutuhan beras. Namun pesatnya pertumbuhan daerah industri sepanjang 

pantai utara Propinsi Jawa Barat (Pantura) terutama di Kabupaten Bekasi, Karawang dan 

Purwakarta menimbulkan dampak terhadap polakehidupan penduduk di daerah tersebut. 

Permasalahan-permasalahan yang dihadapi saat ini pertama-tama adalah penghidupan 

. yang semulalebih bergantung kepad<J pertanian, telah bergeser kepada penyediaan tenaga 

sektor industri. Permasalahan kedua adalah usia bangunan dan jaringan irigasi yang tidak 

jarang beberapa prasarana irigasi hancur akibat lahan yang berubah fungsi menjadi lahan 

pemukiman atau kawasan industri. 

Kebutuhan lahan baik untuk industri maupun pemukiman bagi tenaga kerja akhirnya 

mendesak dan mengambil lahan yang produktif. Karena perubahan harga lahan dan 

tingginya biaya produksi (akibat berkurangnya tenaga kerja di sektor pertanian) menggiring 

petani pemilik lahan sampai kepada pilihan bertahan sebagai petani atau menjual tanahnya 

dan mencoba mencari penghidupan baru dari penjualan lahan. 

Dengan meningkatnya pembangunan fisik baik untuk pemukiman maupun untuk kawasan 

industri mengakibatkan meningkatnya permintaaan lahan yang pada akhirnya sampai pada 

lahan-Iahan produktif dalam jumlah yang besar. Tanpa adanya upaya-upaya perbaikan . 

fungsi jaringan tersebut dikhawatirkan kepasitas jaringan akan semakin menurun dan akan 

mengakibatkan menurunnya produksi padi. 

Untuk megatasi dan mencegah makin menurunnya lahan produksi, efisiensi pemanfaatan 

air pad a jaringan irigasi Jatiluhur, diperlukan inventarisasi yang dapat mengumpulkan 
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informasil data yang akurat mengenai kondisi jaringan, bangunan dan luas areal irigasinya 

pad a saat ini. • 

Data, I Informasi tersebut akan dimasukkan ke dalam sistem data dasar sehingg~.seluruh. 

informasi dapat diketahui secara cepat, aktual dan akurat. Dengan diketahuinya informasi. 

tentang kondisi jaringan irigasi, bangunan air dan fungsinya maka dapat disusun suatu 

sistem informasi yang dapat memberikan gambaran tentang pola pengelolaan yang optimal" 

dan prioritas pemeliharaan dan rehabilitasi yang diperlukan. 

Untuk itu maka disusunlah sebuah Perangkat Lunak untuk komputer personal (PC) yang 

dapat menampilkan informasi-informasi tersebut. Tampilan informasi ini dalam bentuk visual 

(tampilan di layar komputer) maupun hardcopy (cetakan di kertas). 

1.2 Tujuan 

Buku Panduan Pengoparasian Perangkat Lunak Sistem !nformasi Geogrc<fis (PL S!G) , 

Proyek Irigasi Jawa Barat (PIJB) yang dalam· proyek ini meliputi POJ Divisi Timur dan 

sebagian kecil POJ Divisi Tengah, disusun dengan maksud untuk memberikan kemudahan : 

untuk para pengguna dalam mempelajari dan menggunakan perangkat lunak ini. Perangkat 

lunak ini dibuat dengan sistem operasi Windows '98 yang lebih interaktif dibandingkan • 

sistem operasi DOS atau Windows versi sebelumnya, sehingga untuk memahaminya relatif 

lebih mudah, terutama bagi mereka yang telah terbiasa menggunakan sistem operasi 

Windows. 

1.3 Perangkat Keras dan Perangkat Lunak yang Dibutuhkan 

Untuk dapat menjalankan PL SIG PIJB dengan baik maka diperlukan sebuah komputer 

dengan spesifikasi sebagai berikut: 

1. Prcisesor Pentium 100 atau yang lebih tinggi. 

2. RAM minimal 16 MB. 

3. Monitor SVGA dengan VGA Card. 

4. Hard disk dengan ruang yang tersedia minimal 200 MB. 

Sedangkan perangkat lunak yang dibutuhkan adalah: 

1. Sistem Operasi Windows '98 
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2. Microsoft Office '97 

3. Mapinfo versi 4.1 (tersedia pada CO PL-SIG PIJB) 

1.4 Istilah-istilah yang Digunakan 

Oi dalam Buku Petunjuk Pengoperasian PL SIG PIJB ini terdapat istilah-istilah yang 

berkaitan dengan perangkat lunak Mapinfo yang dipakai untuk membuat perangkat lunak ini 

yang mung kin belum dikenal. Agar buku petunjuk ini dapat semaksimal mungkin dipahami 

dan informatif, beberapa istilah-istilah tersebut diterangkan terlebih dahulu. 

Berikut ini beberapa istilah yang akan ditemukan di dalam Buku Petunjuk Pengoperasian PL 

SIG PIJB. 

Jendela Peta 

Jendela Peta adalah jenis jendela tempat gambar-gambar peta dibuat. Semua peta yang 

ada di perangkat lunak ini dibuat di dalam jendela peta. Gambar-gambar lain yang dibuat 

dalam jendeia jenis ini adalah foto dan gambar penampang saluran. 

Jendela· jenis ini(jendela petal dilengkapi dengan sistem koordinat· kartesian sehingga 

• posisi suatu objek dapat diketahui dengan baik. Posisi cursor pad a jendela ini. pun dapat 

,. ditampilkan di sudut kiri bag ian bawah monitor bila status bar yang dipilih adalah koordinat 

cursor (lihat shortcut petal. Satu lagi ciri dari jendela peta adalah daerah di dalamnya tidak 

mempunyai batas kanan kiri atau atas bawah. Contoh jendela peta dapat dilihat pad a 

Gambar1.1. 

: 

• 

Jendela Layout 

Jendela layout adalah jendela yang berguna untuk keperluan pencetakan. Ciri-ciri dari 

jendela jenis ini adalah di dalamnya terdapat batas yang jelas yaitu batas ukuran kertas 

yang akan digunakan untuk pencetakan. Ukuran kertas pada jendela layout ini dapat diu bah 

melalui sub menu setup halaman pada menu file . 

Ciri yang lain dari jendela jenis ini adalah adanya penggaris (ruler) pad a sisi atas dan kiri 

jendela. Contoh jendela layout dapat dilihat pada Gambar 1.2. 
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Jendela Browser 

Jendela ini adalah jendela yang di dalamnya terdapat tabel sederhana yang memuat data­

data 6bjek yang ada pada suatu layer. Jendela ini berkaitan dengan jendela peta tempat, 

objek-objek yang bersangkutan berada. 

Di sisi paling kiri di dalam jendela browser terdapat kotak-kotak yang dapat dipilih. Bila kotak. 

itu dipilih, maka kotak tersebut akan menjadi berwarna hitam dan objek yang bersesuaian 

dengan kotak yang dipilih tersebut akan terarsir (model terpilih). Begitu. pula sebaliknya, bila 

ada suatu objek yang dipilih di jendela peta, maka kotak pad a jendela browser untuk objek 

yang bersesuaian akan berubah menjadi hitam. Contoh jendela browser dapat dilihat pada 

Gambar 1.3. 

Jendela info 

Jendela ini akan muncul bila kita mengaktifkan sub menu info (ditandai dengan berubahnya 

pointer menjadi sebuah crosshair), kemudian memilih suatu objek. Jendela jenis ini berisi • 

data-data penting yang berkaitan dengan objekyang dipilih . 

. Hanya objek yang menyimpan informasi sajalah yang datanya dapat ditampilkan di jendela : 

'info ini. Contoh jendela 'info ini dapat dilihat pada Gambar 1.4. 

Dialog Box 

Sebuah kotak yang munculdi monitor dan berfungsi untuk melakukan hubungan dengan 

pengguna dalam menerima/memberi informasi atau masukan. Dialog Box ini paling sedikit 

dilengkapi dengan tombol OK (OK Button) yang harus dipilih oleh pengguna bila telah 

. selesai mengatur informasi atau masukan yang diinginkan. Contoh-contoh dialog box dapat 

dilihat pad a Gambar 1.5. 

Tool Bar 

Tool Bar adalah suatu bar (batang) yang terdiri dari icon-icon yang dapat dipilih untuk 

melakukan perintah sesuai dengan fungsinya masing-masing. Pad a perangkat lunak ini 

• 

: 

terdapat dua buah tool bar yaitu Menu Tombol dan Edit Gambar. • 
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~Pe'a POJ I!I~Ei 

.!.I 

Gambar 1.1 Contoh jendela peta 

• 
!l!!;Layoul-O. ~ 

• 

• Gambar 1.2 Contoh jendela layout 

1-5 



Petunjuk Pengoperasian PL SfG PIJB 

~Browser tab.1 Bmcp . Ei 
I BMlep I x (meter) I Y (meter) I Eleva.; (meter) I A 

o BW.CP.1 -2_937.488 -35.491.887 25.151 

o CPH.2 -3_009.930 -35.485.194 

o BM.BCP.1 -2.891.886 -34.694.018 

o CP.BCP.1 -2.845.216 -34.660.043 

o BM.BSB.1 -2.553.139 -34.320.424 
o BM.BSB.2 -2.173.696 -34.300.774 
o CP.BSB.2 -2.023.692 -34.295.251 
o BM.BSB.3 -1.392.139 -33.215.028 
o BM.CP.4 -1.352.878 -33.080.370 
o BM.BSB.4 -1.294.970 -32.122.175 
o CPAM.6 -1.142.082 -32.035.981 
o BM.BSB.5 -1.143.500 -31.400.585 

~ 

Gambar 1.3 Contoh jendela browser 

Jendela Info £J 
Nomenklatur: 1 

Jenis: Sekunder 

DI: Cipancuh 

Seksi: 

Kabupaten: 

Divisi: POJ Timur 

Wilayah: POJ 

Luas_La,yanan: 0 

Paniang: 6.268.6 

Saluran ~ 

Gambar 1.4 Contoh jendela info 

30.210 
23.975 

23.794 
23.244 
22.666 
22.668 

22.791 

21.382 
20.336 
20.513 

20.0:rf1 
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Query - Ei 

Pilih tabel: I Lahan "'( . '. 

Krfrecia: I Luas 3 n 100 

QK ]latal 

Petunjuk Pengoperasian PL SIG PIJB 

Pilih Skema f3 

.Skema: 

QK 

Status: 

r. ,!;ksisting 

(' !Jsulan 

]latal 

Gambar 1.5 Contoh-contoh dialog box 
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BAB II 

MENGINSTALASI PL SIG PIJB 

2.1 Menginstalasi PL SIG PIlB 

Perangkat Lunak Sistem Informasi Geografis (PL SIG) PIJB tersimpan di dalam sebuah CD­

ROM. Berikut ini adalah langkah-Iangkah untuk menginstalasi perangkat lunak tersebut. 

1. Masukkan CD-ROM yang berisi PL SIG PIJB di CD-ROM Drive. 

2. Jalankan Windows Explorer. 

3. Tunjuk direktory PJJB pad a Drive CD-ROM dan tekan CTRL-C 

4. Tunjuk Drive C dan tekan CTRL-V 

5. Klik menu Start> F!.UN pad a Windows '98 (Gambar 2.1) dan ketik: 

C:\PIJB\Setup.exe [OK] 

...•......... ,- -....... -................................... _ ............................ _ .. _ ...... _ .. '::~:::. 

Q.pen: 

Type the name of ~ program, folder, document or Internel 
resource, andWlrldows will open ~ for you. 

OK Cancel Hrowse ... 

Gambar 2.1 Dialog Run pada Windows '98. 

6. Tunggu proses instalasi hingga di layar komputer muncul komentar seperti terlihat pacta 

Gambar 2.2a dan Gambar 2.2b (Klik tombol OK pada kedua komentar tersebut) 

/I -1 
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:-:.: .. ,.c, .. _ 

MaplnfohllsbeensJeceS!;fully installed! 

If your Maplnfo networkserverhas'been'configured for installation of 
Video ForWindowssupportfiles;,youjrMJI,have,amopportunity to 

install these 'optional ,files'at this ,tilrie. 

_,i' 

The installation process will concludeifyciur Maplnfo server has not been 
configured to support these files. 

-::-Maplnfo Professional 4.1 Selup_ I!!I~ £! 

Gambar2.2 Proses Instalasi Maplnfo selesai. 
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7. Tunjuk icon Mapinfo ~rofessional 4.1 dan klik sekali lagi untuk merubah menjadi PL 

SIG PIJS seperti ditunjukkan pada Gambar 2.3a dan Gambar 2.3b . 

:.;t Maplnfo I!I~ El :.;t Maplnfo I!I~ El 

<? ¢. rhl ~ ~ <? .c;>·rhl 

~ ~ [ ~ [ 
MapSasic 4.1 • Wo MapSasic 4.1 I:Hf,W'i!J:1 Wo .. .- Nort Nort 

~ I:S . ' 

£ 
, 

£ 
a. 11 obiectls) selected b. 

Gambar 2.3 Mengubah Icon Mapinfo Professional 4.1 menjadi PL SIG PIJB. 

8. Klik tombol kanan mouse pada PL SIG PIJS uniuk memilih menu Properties pada menu 

dialog seperti ditunjukan pad a Gamba. ZA. 

~ ~ ~ 
Ii! Qpcn 

\1/ ork$pace . 

Scon f", \jNscs 
WliShingtO ... 

~ 
2JlckYlcw 
AddtoZ<> 

Wockspace· 101, Send 10 • 
World 

~ 
S;opy 

Create Slorta.t 
t!eletc 
Rename 

I~ My Comput .. Ai 

Gambar 2.4 Menu dialog yang muncul setelah meng-klik tombol kanan 
mouse pada icon PL SIG PIJB. 
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9. Setelah muncul menu dialog Properties kemudian pilih menu Shortcut. Ganti larget: 

dari 
, 
menjadi 

~tart in. 

dari 

rnenjadi 

Run: 

dari 

menjadi 

C:IPIJ8IMAPINFOW.EXE 

C:IP/J8IMAINIP/J8.M8X 

C:IPIJ8 

C:IP/J8 

NORMAL WINDOW 

MAXIMIZED 

I1tSIGPlJaProperbes DEi 

Genet'" Shortcut I 
PLSIG PUB 

T orge( I,ype: 

T arge( location: Mapi-io 

lecget- 1C:\PIJB\MAPINFOW.E>a2: 

I~\PIJ' 

fnd T «got.. I p,..",.1_ .. I 

OK 

a. 

I"LSIGFJJ6Propert.es liE! 

.. ~ PLSIG PUB 

--_ .. _-_ •. _--
. Target t,ypc: 

Torgel.1ocaOOn: Mapno 

_ I«oet IC:\PUB\PUB.MBX 

SIMI;' J~\PIJ~ 

S~~~~ h.IN~~----------------

}NormaIwmow 

. I OK 

b. 

Gambar 2.5 Mengedit Shortcut pada Icon PL SIG PIJB. 

Setelah instalasi selesai kita periu menghilangkan atribut read-only pada semua file yang 

ada di dalam direktori PIJB yang baru diinstalasi itu. 

Caranya: 

1. Jalankan program MS-DOS 

2. Masuk ke direktori PIJB yaitu sampai terlihat tulisan C:IP/J8> 

3. Ketik: attrib -( /s [enter] 

4. Selesai 
.; 
i 
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Petunjuk Pengoperasian PL SIG P/JB 

2.2 Cara Menjalankan Perangkat Lunak 

Setelah selesai di-install, perangkat lunak ini siap untuk digunakan. Cara manjalankan 

Perangk~t Lunak SIG PIJS ini adalah dengan meng-klik Shortcut Icon PL SIG PIJS seperti 

terlihat pada Gambar 2.7. 

@lAdobe 
®Adobe k_ 
t.@App!icationS' 

L:BAc<oCAD 
~AttoCAD R1<f 

.®Co<dS 
®H3e>t.d M<thOOs 

(§Intefnet Explorer 

• 

:: .. ~ 5~1im ®I"""""T""" 
'Ill Maplnfo • ~_ •. I. . 

®"",0>0Ii Pki..r98 . 
~r.krosoft Reiefeoce 

_-=--~=='" ~Power ~[ 
G!lREI ApprlCationS' 

L:!ijSmod. 

• C:BSt"'lJp 

. "."Il Workspace - North America 

'·l!l:lw_.W_onoc 
, mw_.wo<~ 
~PLSIGPIJB__ . 

(§5tudent Reference lbrary • 

(j !!orunentS 

~J1~"", 

~Bnd 

• ®W""~ '. 
~ACDSee32Brow~r I .... ~'r 

.. ~fortran Power statiori 

~-­• ~_osoftExcd 
~_osoft_ 

llf_osoft WO<d 

irrl Roo... mMS-OOS Prompt 
... _._ ._._. __ . __ .. _.~_._ (iVlSfo Tecl-rical<f.l 

~ SlV:Oown... ©.I-"""" ... 
®Short~ to Sm3da 

2.0 

Gambar 2.7 Shortcut Icon PL SIG PIJS (terdapat pada Start menu> Programs> Maplnfo). 

, 
L ___ _ 
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3.1 Tingkatan Menu 

BAB III 
STRUKTUR MENU UTAMA 

Perangkat Lunak Sistim Informasi Geografis PIJS mempunyai empat tingkatan menu yaitu: 

• Tingkat pertama, PIJS 

Tingkatan pertama adalah tingkatan PIJS (Proyek Irigasi Jawa Sarat) yang menampilkan 

Peta Jawa Sarat dengan batas daerah POJ (Perum Otorita Jatiluhur). Tampilan 

Perangkat Lunak ini pada tingkatan yang pertama dapat dilihat pada Gambar 3.1 

• Tingkat kedua, POJ (Perum Otorita Jatiluhur) 

Tingkatan kedua adalah tingkatan POJ (Perum otorita Jatiluhur), sedangkan PO lainnya 

tidak bisa dimasuki karena tidak termasuk lingkup proyek ini. 

Peta yang ditampilkan adalah Peta Oaerah Perum Otorita Jatiluhur dengan batas-batas 

divisi yang ada. Tampilan pada tingkatan ini dapat dilihat pad a Gambar 3.2 

- • Tingkat ketiga, Oivisi 

• 

Tingkatan yang ketiga adalah tingkatan Oivisi. Tingkatan ketiga ini terbagi menjadi dua 

macam yaitu Tingkatan Oivisi dengan Satas Seksi yang menampilkan Peta Oivisi dengan 

batas-batas seksi yang ada di dalamnya (Gambar 3.3) dan Tingkatan Oivisi dengan 

Satas Oaerah Irigasi yang menampilkan Peta Oivisi dengan batas-batas 01 yang ada di 

dalamnya (Gam bar 3.4). 

Tingkatan ketiga yang dapat dimasuki adalah Oivisi Timur dan Oivisi Tengah. Sedangkan 

yang lainnya tidak termasuk ke dalam lingkup proyek kali ini. 

: . Tingkat keempat ,01 (Oaerah Irigasi) 

• Tingkatan keempat adalah tingkatan 01 (Oaerah Irigasi) yang menampilkan.Peta Oaerah 

Irigasi. Oi dalam peta 01 tersebut terdapat gam bar-gam bar atau simbol-simbol yang 

menyimpan informasi seperti saluran, bangunan irigasi,lahan dan juga SM/CP. Contoh 

tampilan pada tingkatan ini dapat dilihat pada Gambar 3.5. 

Secara umum tingkaian-tingkatan tersebut mempunyai struktur menu ~.ebagai berikut: -

1. File 

111-1 
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2. Tingkatan (selalu berubah tergantung tingkatan menu yang sedang aktif) 

3. Stasiun (hanya ada pada tingkatan ke tiga) 

4. Topl 

5. Jendela 

6. Keterangan 

...... 
f:1 £~e BJ6 TIlOI ""ndllr., .IS"""rtIIIg .... 

I' 0Jelol iJGII'1lI!:lI"1 

o 
+ 

+ + 

+ + 

•• I, •• I 

lAUIAtl EN(I'JUESIA 

+ 

Gambar 3.1 Tampilan pada tingkatan yang pertama 

+ 

.. 
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"'Mo~lnfo PJofeSSronlll-tPelaPOJ] Jl!!lfaE3 
~ E~e POJ TQoI JllndIiIlo. f>ilCel'lln9atr 

[I\§!§InI ihmill1lioiOli 

,I 
To'i6j9', -6.126' 

Gambar 3.2 Tampilan pada tingkatan yang kedua 

"'Mo~ln'o ProfeSSlonlll-{PeIIl POJTirnu, dl1nqlln Bolos Sck~lIl "913 
~ file POJTImUf T.Il.OI .!endela ~rr:tngr:tn 

[I\§!§InI iilTIlill1liaiai 

= 

/Editing: None 

Gambar 3.3 Tampilan pada tingkat ketiga (Peta Divisi Timur dengan batas Seksi) 
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" .'" :. ,- -.. 
a Etle POJT_ StMiun TQ.oI .(andele ~.M:VI9an 

~ 0.10.101 i IGII rn:lltllal 

= 

'I 
"109961'. -6.2.0\0' 

Gambar 3-4 Tampilan pacta tingkat ketiga (Peta Divisi Timur ctengan batas DI) 

"'Mltplnlo ProlesslOnltl~(Pelc Dllerch IflCI!lSI CuruCi ACiunClJ 
G fIle CuougAgung Tao' Jendele t;elarangan 

~ 0.10.101 i IGiI rn:ll!:llal 

-I 
107.13S0'A.sil1-· ----fE(Iiting:None 

, , 
-""' ::) c· 
"1· , 
A. :', 
.. ~ 
~..: 

.. 

Gambar 3.5 Contoh tampilan pacta tingkat keempat (Peta Daerah Irigasi) 
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3.2 Menu File 

Menu file ini terbagi menjadi beberapa sub menu, yaitu: 

• Edit 

Sub menu ini hanya aktif bila tingkatan yang aktif adalah tingkatan ke-empat yaitu 

tingkatan 01 (Daerah Irigasi) dan berfungsi untuk memilih layer yang akan diedit. Bila sub 

menu ini dipilih maka akan ditampilkan sebuah. dialog box yang memungkinkan 

pengguna untuk memilih layer yang akan diedit. 

• Simpan 

Sub menu ini berfungsi untuk menyimpan perubahan-perubahan yang telah dibuat. Bila 

sub menu ini dipilih maka akan ditampilkan sebuah dialog box yang mengharuskan 

pengguna untuk mengisi sebuah password. Bila password-nya tidak diketahui maka 

perubahan-perubahan yang telah dibuat tidak akan dapat disimpan. 

• Query Data 

Sub menu ini berfungsi untuk menampilkan rekapitulasi data yang tersedia pad a . 

tingkatan menu tertentu. Data-data beserta batasan-batasannya dapat ditentukan 

melalui dialog box yang tampil bila sub menu ini dipilih. 

• Update 

Sub menu update ini terbagi menjadi tiga sub sub menu, yaitu: 

1. Password 

Sub menu ini berfungsi untuk merubah password yang ada. Bila sub menu ini dipilih 

maka akan tampil satu dialog box yang mengharuskan pengguna PL ini untuk 

memasukkan password lama. Bila password itu benar maka akan tampil lagi satu 

dialog box untuk memasukkan password baru. Pengetikan password baru harus 

dilakukan dua kali pada dialog box tersebut. Bila tidak ada perbedaan pad a dua kali . 

pengetikan password baru, maka password baru tersebut akan dicatat. 

2. Peta Dasar 

Sub sub menu ini berfungsi untuk meng-import file dasar.dxf yang sudah di-edit 

untuk menggantikan peta dasar yang ada sekarang untuk setiap tingkatan. File 

dasar.dxf untuk setip peta di PL SIG ini sudah tersedia, dan bila ingin menguJah peta 
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dasar yang dipakai, maka pengguna dapat meng-edit fie dasar.dxf terse but dengan 

ketentuan-ketentuan tertentu. 

3 .• Data 01 

• 

Setiap perubahan-perubahan data yang berkaitan dengan objek yang ada di dalam 

peta pada Perangkat Lunak ini, akan dihubungkan dengan file-file yang ditampilkan _ 

pad a Perangkat Lunak Microsoft Excel. Oleh karena itu setiap pengguna selesai 

melakukan perubahan-perubahan objek yang mengakibatkan berubahnya data, 

seperti merubah luasan lahan dan panjang saluran pada peta, pengguna harus 

mengaktifkan sub sub menu ini untuk menjadikan data-data baru hasil perubahan 

tersebut dapat diterima oleh Microsoft Excel. 

·0 Setup halaman 

Sub menu ini berfungsi untuk mensetup halaman, printer dan lain-lain yang berhubungan 

dengar. pencetakan (printing). 

o Cetak 

Serfungsi untuk mencetak gam bar yang kita inginkari. Jendela yang akan dicetak secara 

otomatis adalah jendela layout. Sila tidak ada jendela layout yang terbuka, hlaka jendela 

yang aktiflah yang akan dicetak. 

o Keluar 

Serfungsi untuk menutup PL SIG PIJB. 

Sub-sub menu pada Menu File ini dapat dilihat pada Gambar 3.6. 
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Gambar 3.6 Sub-sub menu pada Menu File 

3.3 Menu Tingkatan 

Pada menu tingkatan ini judul menu dan sub-sub menunya akan berbeda pada tiap 

tingkatan. Menu-menu tersebut pada tiap tingkatannya dijelaskan di bawah ini. 

3.3.1 Tingkatan pertama 

Pada tingkatan pertama menu ini mempunyai judul menu PIJB, dan mempunyai beberapa 

sub menu yaitu: 

: • Struktur Organisasi 

• Sub menu ini berfungsi untuk menampilkan Bagan Struktur Organisasi Panitia Air atau 

Bagan Struktur Organisasi POJ. Jenis Bagan yang akan ditampilkan dapat dipilih dari 

dialog box yang tampil bila sub menu ini dipilih. 

• Luasan Daerah Irigasi 

Sub menu menampilkan Tabel Luas Areallrigasi Perum Otorita Jatiluhur. 
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• Neraca Air 

• Sub menu menampilkan Grafik Perbandingan Debit Ketersediaan dan Kebutuhan untuk 

PQJ secara total, maupun untLik setiap divisi-divisi yang ada di bawah POJ. 

• Peta Lebih Rinci 

Sub menu ini berfungsi untuk masuk ke tingkat yang lebih rendah atau masuk ke tingkat 

Perum Otorita Jatiluhur. 

Semua sub menu pada menu ini hanya aktif bila ada objek atau daerah PO yang ditunjuk I 

dipilih. Susunan sub sub menu untuk menu ini dapat dilihat pada Gambar 3.7. 

3.3.2 Tingkatan kedua 

Pad a tingkatan ini judul menunya dalah POJ. Sub-sub menu yang ada pad a menu ini yaitu: 

• Struktur Organisasi 

Sub menu ini bcrfungsi untuk menampilkan Bagan Struktur Organisasi dari drvi:;;i yang 

dipilih padapeta. 

• Luasan Daerah I rigasi 

Sub menu ini berfungsi untuk menampilkan Tabel Luas Areal Irigasi untuk divisi yang 

dipilih pada peta. 

• Neraca Air 

Sub menu ini berfungsi untuk menampilkan GrafikPerbandingan Debit Ketersediaan dan 

Kebutuhan untuk total satu divisi yang ditunjuk ataupun untuk setiap seksi pengairan 

yang ada dibawahnya. 

• Tanam dan Produksi 

Sub menu ini menampilkan bagan .pola tanam dan produksi pertanian di divisi yang 

ditunjuk. 

• Stasiun meteorologi 

Sub menu ini berfungsi untuk menampilkan Tabel Daftar Stasiun Hujan di divisi yang 

dipilih. 

• Peta Lebih Rinci 

Sub menu ini berfungsi untuk masuk ke tingkat yang lebih rendah atau masuk ke dilrisi 
",'-. " 

yang dipilih dengan batas seksi ataupun batas DI. j 
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• Kembali 

Sub menu ini berfungsi untuk kembali ke tingkat menu yang setingkat lebih tinggi. 

Susunan"sub-sub menu ini dapat dilihat pada Gambar 3.8 . 

3.3.3 Tingkatan ketiga 

Menu yang tampil akan mempunyai judul sesuai dengan Oivisi yang dipilih. Misalkan pada 

tingkatan ketiga ini berada pada Perum Otorita Jatiluhur Oivisi Timur, maka judul menunya 

adalah POJ Timur. 

Tingkatan ketiga ini mempunyai dua jenis yaitu Peta Oivisi dengan Batas Seksi dan Peta 

Oivisi dengan Batas 01. Keduanya mempunyai sub-sub menu yang berbeda. 

a. Tingkatan ketiga dengan batasseksi 

Sub-sub menu yang ada yaitu: 

• Struktur Organisasi 

Menampilkan Bagan Struktur Organisasi di Seksi yangdipilih. 

• Luasan Oaerah Irigasi 

Menampilkan Tabel Luas Areallrigasi di seksi yang dipilih . 

• Neraca Air 

Menampilkan Grafik Debit Ketersediaan dan Kebutuhan untuk seksi yang dipilih. 

• Tanam dan Produksi 

Menampilkan bagan pola tanam dan produksi di seksi yang dipilih. 

• Kembali 

Sub menu ini berfungsi untuk kembali ke tingkat menu yang setingkat lebih tinggi 

yaitu tingkat Perum Otorita Jatiluhur (POJ). 

Susunan sub-sub menu ini dapat dilihat pada Gambar 3.9. 

b. Tingkatan ketiga dengan batas 01 

Sub-sub menu yang ada pada menu ini adalah: 

• Struktur Organisasi 

Sub menu ini berfungsi untuk menampilkan Bagan Struktur Organisasi untuk 

Perkumpulan Petani Pemakai Air di Oaerah Irigasi tersebut 
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• Luasan Daerah Irigasi 

Sub menu ini berfungsi untuk menampilkan Tabel Rekapitulasi Luas Areal Sawah per • 

, Saluran lJtama di Daerah Irigasi yang ditunjuk dan juga Tabel Rincian Areal Sawah 

Saluran Sekunder yang ada di 01 yang dipilih. ", 

• Neraca Air 

Sub menu ini berfungsi untuk menampilkan Grafik Perbandingan Debit Ketersediaan 

dan Kebutuhan di Daerah I rigasi yang dipilih. 

• Tanam dan Produksi 

Sub menu ini berfungsi untuk menampilkan Tabel pola tanam di Daerah Irigasi yang 

dipilih. 

• Data Lain 

Sub menu ini terbagi lagi menjadi beberapa sub sub menu yaitu: 

1. Skema 

Menampilkan Skema-skema yang berkaitan dengan Daerah lrigasi yang dipilih. • 

Skema-skema yang dapat ditampilkan adalah Skema Bangunan, Skema Jaringan 

dan Skema Pembagian Air untuk kondisi eksisting dan usulan. Pemilihan jenis 

skema yang akan ditampilkan dapat dilakukan dengan mempergunakan dialog 

box yang tampil bila sub-sub menu ini dipilih. 

2. Daftar BMCP 

Sub-sub menu ini berfungsi untuk menampilkan Tabel Daftar BM (Bench Mark) 

dan CP (Control Point) yang ada di Daerah Irigasi yang dipilih. 

3. Penguapan 

Sub-sub menu ini berfungsi untuk menampilkan Tabel Besarnya Penguapan yang 

terjadi di Daerah Irigasi yang ditunjuk. 

4. Laporan dan Gambar 

Sub-sub menu ini berfungsi untuk menampilkan Daftar Laporan-Iaporan Proyek 

dan Gambar-gambar yang berkaitan dengan Daerah Irigasi yang dipilih. 

5. Kantor dan Rumah Dinas 
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Sub-sub menu ini berfungsi untuk menampilkan Tabel Oaftar Kantor dan Rumah 

Oinas di Oaerah Irigasi yang ditunjuk. 

6, Peralatan dan Mesin 

Sub-sub menu ini berfungsi untuk menampilkan Tabel Oaftar Peralatan dan 

Mesin yang ada di Oaerah Irigasi yang ditunjuk. 

• Peta Lebih Rinci 

Sub menu ini berfungsi untuk masuk ke tingkat menu yang berada setingkat di 

bawahnya yaitu ke tingkat 01 (Oaerah Irigasi). 

• Kembali 

Sub menu ini berfungsi untuk kembali ke tingkat menu yang berada setingkat di 

atasnya yaitu ke tingkat kedua. 

Susunan sub-sub menu ini dapat dilihat pad a Gambar 3.10. 

3.3.4 Tingkatan keempat 

Tingkatan keempat ini adalah tingkatan yang menampilkan peta 01 yang dipilih. Bila kita 

berada pada 01 Cipancuh, maka menunya akan berjudul Cipancuh. 

Sub-sub menu yang ada pad a menu ini adalah: 

• Organisasi P3A 

Sub menu ini akan aktif bila ada objek lahan yang dipilih. 

Bila sub menu ini dipilih maka akan ditampilkan Bagan Stuktur Organisasi Perkumpulan 

Petani Pemakai Air di lahan yang dipilih. 

• Foto 

Sub menu ini hanya berfungsi bila ada objek bangunan atau saluran yang dipilih. 

Sub menu ini berfungsi untuk menampilkan foto dari objek yang dipilih baik bangunan .• 

maupun saluran. Foto-foto yang tersedia maksimum 5 ·buah dan pengguna harus 

memilih salah satu dari lima foto tersebut yang akan ditampilkan dengan 

mempergunakan dialog box yang tampil bila sub menu ini dipilih. 

• Penampang 

Sub menu ini berfungsi untuk menampilkan gam bar pen am pang melintang dari saluran 

yang dipilih. Jadi sub menu ini hanya aktif bila ada objek saluran yang dipilih. 
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• Cari Lokasi 

Sub menu ini belfungsi untuk mencari lokasi objek yang ingin kita ketahui. Bila sub menu 

ini dipilih maka akan muncul sebuah dialog box untuk menentukan jenis dan nama objek 
~ . 

yang akan dicari lokasinya. Bila objek yang dipilih sudah ditentukan maka pengguna • 

dapat menekan tombol OK pada dialog box tersebut, dan lokasi objek yang dimaksud 

akan ditandai dengansebuah lingkaran. 

• Kembali 

Sub menu ini berfungsi untuk kembali ke tingkat menu yang setingkat lebih tinggi. 

Susunan sub-sub menu pada menu ini dapat dilihat pada Gambar 3.11. 

;!.~ . 

. -~. 
,~ 
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Gambar 3.7 Sub-sub menu pad a Menu PIJB (tingkatan pertama) 
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Gambar 3.8 Sub-sub menu pada Menu POJ (tingkatan kedua) 

111-13 



Petunjuk Pengoperas;an PL SIG P/JB 

'Moplnfo Profossiono.l- {pelo POJ Timur dengan Bntns Sekai] "fJEt 
~ file I POJTICIIUI' T201 Jendelo. ~rongM 

~ S\ruktufOcgM~CI.$i 
LUCI.$M Ooerch lrigas; 
l!I.erocoAil' 
IMGIQ dM ProduksL. 

"".K = 

.!l ..J !: 
101532'.-5.688" IEd<l>ng:None -r-r---

Gambar 3.9 Sub-sub menu pada Menu POJ Timur (tingkatan ketiga dengan batas seksi) 
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Gambar 3.10 Sub-sub menu pada Menu POJ Timur (tingkatan ketiga dengan bata~ 01) 
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Gambar 3.11 Sub-sub menu pada Menu Pedati (tingkatan ke empat) 

3.4 Menu Stasiun 

Menu ini hanya muncul bila pengguna sedang berada pad a tingkatan ketiga dalam 

Perangkat Lunak ini dan terbagi menjadi dua sub menu yaitu: 

• Hujan 

Sub menu ini menampilkan data curah hujan untuk stasi un pencatat hujan atau stasiun 

• meteorologi yang dipilih. Penyajian data curah hujan terse but bisa melalui tabel ataupun 

grafik. 

• Klimatologi 

Sub menu ini menampilkan data-data klimatologi untuk stasiun meteorologi yang dipilih. 

Seperti halnya curah hujan, data klimatologi inipun dapat ditampilkan melalui tabel atau 

grafik. 
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3.5 Menu Tool 

Menu ini berfungsi sebagai alat ba.gLpengguna Perangkat Lunak ini dalam berinteraksi atau 
~ . 

bekerja dengan peta yang ditampilkan. Menu Tool ini mempunyai beberapa sub menu yaitu: 
'/ 

• Tunjuk 

Sub menu ini berfungsi untuk menunjuk objek yang ada pad a peta yang ditampilkan. 

Berfungsinya sub menu ini ditandai dengan pointer pad a jendela peta yang berbentuk 

sebuah panah. 

• Perbesar Tampilan 

Sub menu ini berfungsi untuk memperbesar tampilan peta (zoom). Bila sub menu ini 

dipilih maka pointer pad a jendela peta akan berbentuk sebuah kaca pembesar atau 

suryakanta dengan tanda positif (+) di tengahnya. Dengan pointer ini pengguna dapat 

memperbesar daerah-daerah pada peta sesuai dengan yang diinginkan 

• Perkecil Tampilan 

. 

Sub menu ini berfungsi untuk memperkecil tampilan peta. Bila sub menu ini dipilih maka 

pointer pada jendela peta akan berbentuk sebuah kaca pembesar atau suryakanta 

dengan tanda negatif (-) di tengahnya. Dengan sub menu ini pengguna dapat • 

memperkecil tampilan peta pada jendela peta. 

• Geser 

Karena layar komputer sangat terbatas sehinga tidak dapat menampilkan semua objek 

yang "ada pad a peta pada suatu skala tertentu, maka perlu suatu alat (toof) untuk 

menggeser peta pada jendela peta terse but. Sub menu inilah yang dapat digunakan 

untuk menggeser peta pada jendela peta. Bila sub menu ini aktif maka pointer pad a 

jendela peta akan berbentuk sebuah telapak tangan. 

• Info 

• 

: 

Sub menu ini berfungsi untuk menampilkan sebuah jendela info yang berisi informasi- -

informasi yang berkaitan dengan objek yang dipilih. Aktifnya sub menu ini ditandai 

dengan berubahnya pointer pada jendela peta menjadi berbentuk sebuah crosshair (dua 

buah garis pendek, vertikal dan horisontal, yang berpotongan tegak lurus). Untuk 

mengetahui informasi yang ada pada sebuah objek, crosshair terse but harus di-kli~ pada 

objek yang dimaksud 
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• Tutup Toolbar 

Perangkat Lunak SIG PIJB ini dilengkapi dengan sebuah Tool Bar untuk memudahkan 

pengguna untuk memberikan perintah tanpa melalui menu yang ada. Untuk membuka 

atau menutup Tool Bar tersebut dapat digunakan sub menu ini. 

Susunan sub-sub menu pad a Menu Tool ini dapat dilihat pad a Gambaar 3.12. 

~M8 Info Professional .. tpela POJ T,mur denqoft Bat!!s 01] Rr:lD 
f?S::-iPO::-J Ti",mC:;"c::5'=:::c-'IT QOt Jendelo t;;eterengan 

., IUClivk on.A 
I~~~!.,,;!='= PelbesGrTampitan on·a 

Pelt,ecitTampilQ(1 on·S 
,G.esel Ort.R 

Inlo Orr·a 

....... 

Gambar 3.12 Susunan sub-sub menu pada Menu Tool 

3.6 Menu lendela 

Menu ini secara garis besar berfungsi untuk membuka ataupun menutup jendela-jendela 

yang ada pad a PL SIG PIJB ini. 

Menu ini terdiri dari beberapa sub menu yaitu: 

• Buka Browser 

Sub menu ini berfungsi untuk menampilkan (membuka) jendela browser. Bila sub. menu 

ini dipilih, akan tampil sebuah dialog box yang berfungsi untuk memilih jenis browser 

yang akan ditampilkan. Jendela browser ini hanya dapat ditampilkan satu jenis saja. Bila 
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pengguna membuka jendela browser jenis lain maka jendela browser yang lama akan 

otomatis tertutup. 

• Buka Layout , 
Sub menu ini berfungsi untuk menampilkan (membuka) jendela layout untuk keperluan 

pencetakan (printing) ataupun menutupnya. Dengan jendela layout ini· kita dapat 

mengaturjendela apa saja yang akan dicetak dan juga dapat mengatur posisi jendela 

yang akan dicetak terse but pada kertas. 

• Frame 

Sub menu ini berfungsi mengisi jendela layout dengan gambar-gambar yang akan 

dicetak (jendela-jendela yang aktif). Bila sub menu ini dipilih maka akan tampil sebuah 

dialog box untuk memilih jendela apa saja yang akan dimasukkan ke dalam jendela 

layout. 

Sub menu ini aktifhanya jika ada jendela layout yang terbuka. 

Susunan sub-sub menu pada Menu Jendela ini dapat dilihat pada Gambar 3.13. 

" ••• , .. •• -:.' I 

~ E~e POJTImUf StMiun T~I 

"~-.!1!mI ~ 

: .. 
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Gambar 3.13 Susunan sub-sub menu pada Menu Jendela 
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• 3.7 Menu Keterangan 

• Menu ini terdiri dari dua sub menu yaitu: 

• Petunjuk Pengoprasian 

Sub menu ini berisi tentang petunjuk pengoprasian yang dikemas seperti program help 

pada program-program yang berbas;"kan sistem operasi windows secara umum. 

Contoh tampilan petunjuk pengoperasian dapat dilihat pada Gambar 3.14. 

• Info Singkat 

Berisi info singkat tentang Perangkat Lunak SIG PIJB. 

... '., 
,:. Petumuk PengoPBf8SIQn Pl SIG PIJB I!!!lIiID 

~ FI'e [1J9 T~ file Edit BookmCYk Qptions jjelp 

~ IG'l.Ie.loi i l:o""''''' ~._ aod< £;rio< 

_ • x 

!' 

Petunjuk Pengoperasian ;;; 
C.Y •• ",~,. 

Tingkatan Menu 

Stru ktur Men u Utama 
., 

'~' Menu Tambahan 

Editing 

OIArsicon-

<I 
1718.128', -f699' diting:None 

Gambar 3.14 Contoh tampilan dari sub menu Petunjuk Pengopersian 
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BAB IV 
STRUKTUR MENU TAM BAHAN 

Pad a Perangkat Lunak SIG PIJB ini selain mempunyai menu utama yang dijelaskan di Bab 

3, tersedia juga menu-menu tambahan yang akan dijelaskan paCta bab ini. 

4.1 Menu Shortcut Peta 

Untuk menampilkan menu shortcut peta ini pengguna harus menekan tombol sebelah kanan 

(klik-kanan) ketika· pointer berada di jendela peta. Menu Shortcut Peta dapat dilihat paa 

Gambar4.1. 

Sub-sub menu yang ada di menu shortcutpeta ini adalah: 

• Undo 

Sub menu ini beriungsi untuk membatalkan perintah terakhir yang dilakukan oleh 

pengguna dalarn proses peng-edit-an peta. 

• • Hapus 

Sub menu ini beriungsi untuk menghapus objek yang dipilih. 

• Copy 

Sub menu ini beriungsi untuk menggandakan objek yang dipilih. 

• Paste 

Sub menu ini beriungsi untuk mengeluarkan objek yang telah di-copy terlebih dahulu. 

• Redraw Peta 

Ketika bekerja dengan peta atau gambar terkadang gambar tidak tertampilkan dengan 

"" sempurna. Sub menu ini beriungsi untuk menyempurnakan tampilan gam bar yang.ada. 

• Tampilan Sebelumnya 

Sub menu ini beriungsi untuk mengembalikan tampilan peta satu tahap sebelumnya. 

• Tampilan Penuh 

Sub menu ini beriungsi untuk mengatur tampilan peta sehingga semua objek yang ada 

di peta tersebut dapat terlihat. 
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• Bar Status 

Pada sudut kiri sebelah bawah pada Perangkat Lunak ini terdapat bar status yang dapat • 

dipilih jenisnya. Sub menu ini berfungsi untuk memilih jenis bar status yang diinginkan 
~ t 

melalui dialog box yang muncul bila sub menu ini dipilih. 

Jenis-jenis bar status yang dapat dipilih adalah: 

1. Koordinat Cursor 

Jenis ini menampilkan posisi (koordinat) pointer di peta. 

Contohnya di sudut kiri bawah monitor akan tertulis: 1,700 m : -33,700 m. 

2. Skala tampilan 

Bar status dengan jenis ini menampilkan skala tampilan peta di layar monitor. 

Contohnya di sudut kiri bawah monitor akan tertulis: Scale on screen: 1 in = 2,768 m. 

3. Perbesaran kawasan 

Bar status dengan jenis ini menampilkan tingkat perbesaran tampilan peta. 

Contohnya di sudut kiri bawah monitor akan tertulis: Zoom: 22, 000 m 

"::,' 
",' 
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Gambar 4.1 Tampilan menu shortcut peta 
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4.2 Menu Shortcut Layout 

\"/ 
'Z,~~...:/--' 

Untuk menampilkan menu shortcut layout ini, pengguna harus menekan tombol sebelah 

kanan (klik-kanan) mouse, ketika pointer berada di jendela layout. 

Sub-sub menu yang terdapat pada menu ini yaitu: 

• Ubah tampilan 

Sub menu ini berfungsi untuk mengubah skala tampilan pada jendela layout. Bila sub 

menu ini dipilh maka akan muncul satu dialog box untuk menentukan skala tampilan 

.. yang diinginkan (%). 

• T ampilan Aktual 

Sub menu ini berfungsi untuk mengatur tampilan pad a jendela layout sehingga tampilan 

tersebut mempunyai skala 100%. 

• Tampilan Penuh 

Sub menu ini berfungsi untuk mengatur tampilan pad a jendela layout sehingga semua 

objek yang berada di jendela layout tersebut dapat terlihat. 
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• Tampilan Sebelumnya 
~ 

Sub menu ini berfungsi untuk mengembalikan tampilan di jendela layout seperti tampilan 

sel;lelumnya. . .'~ 

...• • 
Susunan menu ini dapat dilihat pada Gambar 4.2. 

• 

• 

Gambar 4.2 Tampilan menu shortcut layout 

4.3 Menu Tombol (ToolBar) • 

Menu tombol adalah Tool Bar yang terletak di bawah menu bar utama pad a layar. Menu .. 

Tombol ini berfungsi untuk memudahkan pengguna dalam bekerja dengan Perangkat Lunak 

SIG PIJB ini. Dengan tersedianya tool bar ini, untuk perintah-perintah tertentu, pengguna 

tidak perlu melakukannya melalui menu tetapi cukup melalui tool bar ini. 

Menu Tombol ini dapat dilihat pada Gambar 4.3. 
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Menu lombol £J 

Gambar 4.3 Susunan icons pada menu tombol 

Menu tombol terdiri dari beberapa bagian yaitu: 

• Tunjuk 

Bagian ini mempunyai icon bergambar tanda panah yang berfungsi untuk memilih atau 

menunjuk objek-objek yang diinginkan. 

• Perbesar 

Bagian ini mempunyai icon bergambar suryakanta dengan tanda positif (+) di tengahnya. 

Berfungsi untuk memperbesar tampilan peta pada jendela peta. 

• Perkecil 

• 

• 

• 

Bagian ini mempunyai icon bergambar suryakanta dengan tanda negatif (-) di tengahnya. 

Berfungsi untuk memperkecil tampilan peta pad a jendela peta. 

Geser 

Bagian ini mempunyai icon bergambar sebuah telapak tang an dan berfungsi untuk 

menggeser peta pad a jendela peta. 

Info 

Bagian ini mempunyai icon bergambar huruf i dan berfungsi untuk menampilkan sebuah 

jendela info yang berisi informasi-informasi penting berkaitan dengan objek yang dipilih. 

Browser Tabel 

Bagian ini mempunyai icon bergambar sebuah tabel yang melambangkan sebuah 

browser. Fungsi bagian ini adalah menampilkan jendela browser. Sebeum menampilkan 

jendela browser, pengguna harus memilih dulu jenis browser apa yang akan ditampilkan 

melalui sebuah dialog box yang tampil bila bag ian ini dipilih I diaktifkan. 

• Layout 

Bagian ini mempunyai icon bergambar sebuah jendela layout dan berfungsi untuk 

menampilkan sebuah jendela layout yang diperlukan untuk keperluan pencetakan. 
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• Frame .. 
Bagian ini berfungsi untuk mengisi jendela layout dengan gambar-gambar yang akan 

dicetak Uendela-jendela yang aktif). Bila bagian ini dipilh maka akan tampil sebui3h dialog. 

box untuk memilih jendela apa saja yang akan dimasukkan ke dalam jendela layout. 

• Cetak 

Bagian ini berfungsi untuk mencetak. Bila ada jendda layout yang aktif, secara otomatis 

jendela itulah yang akan dicetak. Tapi bila tidak ada jendela layout yang aktif maka 

jendela peta yang aktif lah yang akan dicetak. 

4.4 Edit Gambar (Tool Bar) 

Tool Bar Edit Gambar ini berguna dalam proses peng-editan gam bar atau peta. Tool bar Edit 

Gambar ini mempunyai beberapa bagian yaitu: 

• Simbol, berfungsi untuk membuat simboLpada jendela peta 

• Garis, berfungsi untuk membuat garis lurus pada jendela peta 

• Polyline, berfungsi untuk membuat garis dengan banyak node 

• Arc, berfungsi untuk membuat garis lengkung 

• Poligon, berfungsi untuk membuat daerah segi ban yak tak beraturan 

• Ellips, berfungsi untuk membuat ellips 

• Segiempat, berfungsi untuk membuat daerah denga:l bentuk segi empat 

• Segiempat bulat, berfungsi untuk membuat daerah berbentuk segi empat yang sudut­

sudutnya dibulatkan 

• Teks, berfungsi untuk membuat teks 

• Reshape, menampilkan node-node yang ada pada suatu objek polyline atau objek 

polygon 

• Node, bertungsi untuk men am bah node pada polyline atau polygon 

• Layer, berfungsi untuk menampilkan dialog Layer Control 

• Style Symbol, berfungsi untuk mengatur jenis simbol 

• Style Garis, berfungsi untuk mengatur jenis garis 
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• Style Area, berfungsi untuk mengatur jenis polygon 

• Style Font, berfungsi untuk mengatur jenis huruf 

.. • Simpan, berfungsi untuk menyimpan (saving) perubahan-perubahan yang telah dibu§lt 

Tool Bar Edit Gambar dapat dilihat pada Gambar 4.4. 

@n'.xll 
............ ". 
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Gambar 4.4 Tool Bar Edit Gambar 

• 

• 
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5.1 Umum 

BABV 

EDITING 

Perangkat Lunak SIG PIJB memberikan beberapa fasilitas untuk melakukan peru bahan­

perubahan pada gambar ataupun data-data yang ada di dalamnya. 

Fasilitas-fasilitas yang ada untuk melakukan perubahan-perubahan tersebut antara lain 

dengan menggunakan sub menu edit pada menu file dan juga sub menu update pada menu 

file. 

5.2 Update-Peta Dasar 

Pada memu file, terdapat.sub menu update yang terbagi lagi menjadi sub sub menu peta 

dasar dan sub sub menu pass,""ord. Sub sub menu peta dasar berfungsi untuk meng-import 

file dasar.dxf untuk mengganti peta dasar yang lama. 

Pengeditan file dasar.dxf itu sendiri tidak dapat dilakukan di perangkat lunak ini, tetapi harus 

dilakukan dengan perangkat lunak yang dapat menerima file *.dxf seperti AutoCad. Setelah 

file dasar.dxf itu died it, barulah PL SIG PIJB meng-import file terse but untuk menjadi peta 

dasar yang baru. 

File *.dxf yang dapat diterima cleh PL SIG PIJB adalah versi 12. 

Beberapa hal yang tidak boleh dilakukan dalam proses pengeditan di perangkat lunak lain: 

Menggeser kedudukan peta, sehingga koordinatnya secara keseluruh;m berubah 

.Memperbesar atau memperkecil peta secara keseluruhan 

5.3 Merubah Luasan Lahan Dan Panjang Saluran 

Data-data luas lahan dan panjang salauran pada perangkat lunak ini diikatkan pada gam bar 

di peta. Bila gam bar saluran pada peta diubah, maka data panjang saluran itupun akan 

berubah pula. JaJi bila data panjang saluran atau luas lahan akan diubah atau diperbaharui, 

V-1 



Petunjuk Pengoperasian PL SIG PIJB 

yang harus dilakukan adalah meng-edit objek-objek yang bersangkutan di peta sehingga 

menghasilkan data seperti yang kita inginkan. • 

Perlu,diperhatikan untuk para pengguna, berkaitan dengan kegiatan merubah luasan lahan 
• 

dan panjang saluran ini, adalah setiap selesai melakukan perubahan-perubahan tersebut, • 

pengguna harus mengaktifkan sub sub menu Data DI yang berada pada menu File pada sub 

menu update. Tujuan mengaktifkan sub sub menu Data DI tersebut adalah agar data-data' 

beru yang baru saja dibuat (dari perubahan-perubahan luasan dan panjang saluran) dapat 

diterima oleh file-file yang ditampilkan pada Perangkat Lunak Microsoft Excel. 

Berikut ini dijelaskan tahap-tahap kegiatan merubah luasan lahan atau panjang saluran. 

Masukan Perangkat Lunak pad a tingkatan yang keempat yaitu tingkatan Daerah Irigasi. 

Pilihlah tabel yang akan diedit melalui menu File>Edit. Bila yang akan kita ubah adalah 

luasan lahan, maka tabel yang harus kita pilih adalah tabel lahan. Begitu pula bila·-kita 

ingin merubah panjang saluran, tabel yang kita pilih adalah tabel saluran. 

Pilih objek yang akan kita edit pada tabel yang telah kita tentukan. 

Pilih bag ian reshape pada Tool Bar Edit Gambar yang tersedia sehingga setiap node 

pada objek yang dipilih dapat te,lihat. 

Untuk merubah luasan atau panjang saluran, pengguna harus merubah posisi node-node • 

- objek yang bersangkutan sehingga menghasilkan data yang diinginkan. Bila node-node 

itu dinilai kurang banyak, dapat ditambahkan dengan memilih bagian node pada Tool Bar 

Edit Gambar, kemudian di-klik pada tempat yang ingin ditambah node-nya. 

-
Setelah dilakukim perubahan pada objek, nilai luas lahan atau panjang saluran yang 

baru dapat ditampilkan pada jendela pesan atau bisa pula melalui jendela browser. Untuk 

mengetahui nilai yang baru terse but pengguna harus meng-klik pointer di luar objek 

yang bersangkutan untuk membuat objek terse but tidak berada pad a mode terpilih, 
• 

kemudian di-klik kembali di objek yang bersangkutan untuk mengembalikan objek pada 

mode terpilih. Pada saat itu nilai yang baru dapat dilihat pada jendela pesan atau jendela • 

browser. 

Proses itu terus dilakukan hingga nilai yang diinginkan dapat tercapai. 

Setelah melakukan peng-edit-an jangan lupa untuk menyimpan hasil perubahan­

perubahan yang telah dibuat dengan cara memilih menu File>Simpan. Untuk dapat 

- menyimpan perubahan-perubahan ini, pengguna harus mengetahui password-nya. Ini 

dimaksudkan agar tidak semua orang dapat melakukan perubahan pada peta. 
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Setelah selesai menyimpan, data-data baru tersebut harus di-update dengan cara 

memilih menu File>Update>O~ta Oi, sehingga data-data hasil prubahan dapat diterima 
. ~ .. 

oleh file yang ditampilkan dengan perangkat lunak MicrosofH:xcel. 

5.4 Mengganti atau Manambah Foto 

Foto-foto yang ditampilkan pad a perangkat luna.k ini tersedia di file-file *.jpg. Jadi bila ingin 

mengganti atau menambah foto-foto tersebut, yang harus dilakukan adalah mengganti atau 

menambahkan file *.jpg-nya dengan nama file yang mengikuti aturan. 

Tempat file-file foto tersebut terletak di: 

C: \PI JB \ POJ\DIRECTORYDIVISI\DIRECTORYDI\ FOTO \ FILE _ JPG 

Directory divisi adalah nama divisi tempat foto itu berada. 

Directory 01 adalah nama 01. tempat foto itu berada. 

File adalah nama bangunan atau saluran yang fotonya akan diganti. 

Contoh, bila foto yang akandiganti adalah foto. ke satu dari bangunan Bcp.1 a di 01 

Cipancuh, maka tempat foto tersebut adalah: 

G.:\PIJB\POJ\POJTIMUR\CIPANCUH\FOTO\BCP1A 1.JPG 

Nama file untuk foto bangunan dan saluran harus sam a dengan nama bangunan dan 

saluran tersebut pada kolom nomeklatur di masing-masing jendela browsernya, dengan 

catatan, semua titik yang ada pad a nomenklatur itu dihilangkan dan kemudian ditambahkan 

dengan nomor foto. 

Contohnya, 

Pengguna ingin menambah foto bangunan BCp.1, dan menjadikannya sebagai foto ke 

\ empat, karena mung kin bangunan tersebut sudah memiliki tiga buah foto. Maka nama file 

*.jpg untuk foto terse but adalah; Bcp1_4Jpg. (Titik pada nomenklatur dihilangkan dan 

• ditambahkan dengan nomor foto _4) . 
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1.1 Latar Belakang 

BABI 
PENDAHULUAN 

Pengembangan lahan gambut untuk pertanian tanaman pang an di Kalimantan Tengah 
dilatarbelakangi oleh kondisi yang disebutkan di bawah ini: 
• Konsumsi beras terus meningkat sejalan dengan pertambahan penduduk. 
• Terjadinya alih fungsi lahan beririgasi menjadi lahan non-pertanian dalam luas yang 

cukup besar, terutama di Pulau Jawa. 
• Terjadinya penurunan produksi beras nasional akibat serangan hama dan kekeringan. 
• International Rice Research Institute (IRRI) memperkirakan trend cadangan beras dunia 

akan terus menurun. 
• Food and Agriculture Organization (FAD) memperkirakan bahwa menjelang tahun 2000, 

Indonesia termasuk salah satu negara yang akan menghadapi krisis pangan. 

Berdasarkan latar belakang tersebut, Pemerintah Indonesia menempuh kebijakan 
peningkatan produksi pangan melalui intensifikasi dan ekstensifikasi. Sebagai salah satu 
upaya ekstensifikasi, dipilih lahan rawa yang potcilsinya sangat besar dan relatif belum 
dimanfaatkan. Hal itu mendasari keluamya Instruksi Presiden RI tanggai" 5 Juni 1995 dan 
ditindaklanjuti dengan Keppres No. 82 tanggal 26 Desember 1995 tentang-Pengembangan 
Lahan Gambut untuk pertanian di Kalimantan Tengah. Pemerintah Republik Indonesia 
melalui Departemen Peke~aan Umum telah mulai membuka lahan yang diawali dengan 
pembangunan prasarana pengairan dan diikuti kemudian dengan penyiapan lahan" dan 
pencetakan sawah serta kegiatan lintas sektoral terkait, antara lain penyuluhan dan 
percontohan pertanian dan pemukiman petani/transmigrasi. 

Pengembangan lahan rawa ini memiliki keuntungan komparatif dibandingkan lahan kering, 
karena di rawa, sumber daya lahan dan sumber daya air terdapat pada lokasi yang sama. 
Selain itu, pengalaman pengembangan lahan rawa selama P JP I menunjukkan bahwa 
lahan rawa memberikan peluang yang cukup besar untuk dikembangkan bagi budidaya 
pertanian" terutama tanaman pangan. 

Sejalan dengan perkembangan yang terjadi, penanganan PLG telah mendapat kritik baik 
dari masyarakat luas maupun para pakar sehingga pemerintah telah melakukan kaji ulang 
untuk menangani PLG secara lebih arif yang hasilnya antara lain adalah bahwa 
pengembangan PLG selanjutnya tidak lagi diutamakan hanya untuk produksi tanaman " 
pang an tetapi akan didasarkan atas kemampuan sumber daya yang ada, serta 
mengutamakan kesejahteraan masyarakat setempat. 

Untuk mendukung hal tersebut Bagian Proyek Pembinaan Ketatalaksanaan merasa perlu 
untuk memberikan dukungan informasi selengkap mung kin dengan mengumpulkan hasil­
hasil studi dan informasi tentang seluruh kegiatan proyek yang pernah dilaksanakan. Oleh 
karena itu diperlukan adanya suatu sistem database yang baik dan handal sehingga semua 
informasi mengenai pengembangan Lahan Gambut dapat diakses dengan cepat. 
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• 
1.2 Tujuan 

Buku 'Panduan Pengoperasian Perangkat Lunak Sisteni Informasi Geografis (PL SIG). 
Database Kesekretariatan PLG ini disusun dengan maksud untuk memberikan kemudahan. 
untuk para pengguna dalam mempelajari dan menggunakan perangkat lunak ini. Perangkat 
lunak ini dibuat dengan sistem operasi Windows '98 yang lebih interaktif dibandingkan 
sistem operasi DOS atau Windows versi sebelumnya, sehingga untuk memahaminya relatif­
lebih mudah, terutama bagi mereka yang telah terbiasa menggunakan sistem operasi 
Windows. 

1.3 Perangkat Keras dan Perangkat Lunak yang Dibutuhkan 
Perangkat Lunak Database Kesekretariatan PLG ini beroperasi di komputer personal (PC) 
dengan sistem operasi Windows, minimal Windows '95. Agar perangkat lunak dapat 
beroperasi dengan baik, diperlukan perangkat keras (hardware) yang memadai. Jika hal ini 
diabaikan maka dapat menimbulkan hambatan atau kegagalan dalam menjalankan 
perangkat lunak tersebut. Sebagai contoh, misalnya, jika digunakan komputer dengan 
prosesor dibawah standar yang ditentukan maka .operasi perangkat lunak menjadi lambat 
atau bahkan dap2t menyebabkankemacetan atau program tidak bis8 dioperasikan. Herikut • 
ini adalah. spesifikasi perangkat keras minimal untuk menjalankan Perangkat- Lunak 
Database Kesekretariatan PLG: 
1. Komputer personal (PC) dengan prosesor Pentium 100 atau yang lebih tinggi. 
2. RAM minimal 32 Mb. 
3. Monitor SVGA. 
4. Hard disk dengan ruang yang tersedia minimal 1.0 Gb. 
5. Seperangkat Multimedia seperti CD-ROM Drive, Sound Card, dan Speaker. (Sound. card 

dan speaker diperlukan jika disediakan fasilitas untuk visualisasi video.) 

Selain perangkat keras, diperlukan juga perangkat lunak yang dapat menunjang' operasi 
dari Perangkat Lunak Database Kesekretariatan PLG, yaitu Microsoft Office '97. 

1.4 Istilah-istilah yang Digunakan 

Di dalam Buku Petunjuk Pengoperaslan Perangkat Lunak Database Kesekretariatan PLG 
ini terdapat istilah-istilah yang berkaitan dengan perangkat lunak Mapinfo yang dipakai • 
untuk membuat perangkat lunak ini yang mung kin belum dikenal. Agar buku petunjuk ini' 
dapat semaksimal mungkin dipahami dan informatif, beberapa istilah-istilah terse but : 
diterangkan terlebih dahulu. 
Berikut ini beberapa istilah yang akan ditemukan di dalam Buku Petunjuk Pengoperasian PL 
Database Kesekretariatan PLG. 

Jendela Peta 

Jendela Peta adalah jenis jendela tempat gambar-gambar peta dibuat. Semua peta yang 
ada di perangkat lunak ini dibuat di dalam jendela peta. Gambar-gambar lain yang dibuat 
dalam jendela jenis ini adalah foto dan g2:nbar penampang saluran. 
Jendela jenis ini (jendela petal dilengkapi dengan sistem koordinat kartesian sehingga 
posisi suatu objek dapat diketahui dengan baik. Posisi cursor pada jendela ini pun dapat 
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ditampilkan di sudut kiri bag ian bawah monitor bila status bar yang dipilih adalah koordinat 
cursor (Iihat shortcut petal. Satu lagi ciri dari jendela peta adalah daerah di dalamnya tidak 
mempunyai batas kanan kiri atau atas bawah. Contoh jendela peta dapat dilihat pada 
Gambar1.1. , 
Jendela Layout 
Jendela layout adalah jendela yang berguna untuk keperluan pencetakan. Ciri-ciri dari 
jendela jenis ini adalah di dalamnya terdapat batas yang jelas yaitu batas ukuran kertas 
yang akan digunakan untuk pencetakan. Ukuran kertas pada jendela layout ini dapat diubah 
melalui sub menu setup halaman pad a menu file. 
Ciri yang lain dari jendela jenis ini adalah adanya penggaris (ruler) pada sisi atas dan kiri 
jendela. Contoh jendela layout dapat dilihat pada Gambar 1.2. 

Jendela Browser 
Jendela ini adalah jendela yang di dalamnya terdapat tabel sederhana yang memuat data­
data objek yang ada pada suatu layer. Jendela ini berkaitan dengan jendela peta tempat 
objek-objek yang bersangkutan berada. 
Di sisi paling kiri di dalam jendela browser terdapat kotak-kotak yang dapat dipilih. Bila 
kotak itu dipilih, maka kotak tersebut akan menjadi berwarna hitam dan objek yang 
bersesuaian dengan kotak yang dipilih tersebut akan terarsir (mode terpilih). Begitu pula 
sebaHknya, bila ada suatu objek yang dipilih di jendela peta, maka .. kotak pad a jendela 
browseruntuk objek yang bersesuaian akan b.erubah menjadi hitam. Contoh jendeia 
browser dapat dilihat pada Gambar 1.3. 

Jendela info 

Jendela ini akan muncul bila kita mengaktifkan sub menu info (ditandai dengan beru6ahnya 
pointer menjadi sebuah crosshair). kemudian menunjuk suatu objek. Jendela jenis ini berisi 
data·data penting yang berkaitan dehgan objek yang dipilih. 
Hanya objek yang menyimpan infonmasi sajalah yang datanya dapat ditampilkan di jendela 
info ini. Contoh jendela info ini dapat dilihat pad a Gambar 1.4. 

Dialog Box 

Sebuah kotak yang muncul di monitor dan berfungsi untuk melakukan hubungan dengan 
pengguna dalam menerima/memberi infonmasi atau masukan. Dialog Box ini paling sedikit 
dilengkapi dengan tombol OK (OK Button) yang harus dipilih oleh pengguna bila telah 
selesai mengatur infonmasi atau masukan yang diinginkan. Contoh-contoh dialog box dapat 
dilihat pada Gambar 1.5 . 

Tool Bar 

Tool Bar adalah suatu bar (batang) yang terdiri dari icon-icon yang dapat dipilih· untuk 
melakukan perintah sesuai dengan fungsinya masing-masing. Pada perangkat lunak ini 
terdapat dua buah tool bar yaitu Menu Tombol dan Edit Gambar. 
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~ Pela Proyek Pengembangan Lahan Gambul (PLG) ll!!lliiI E'! 

Gambar 1.1 Contoh jendela peta. 

~Layoui - ~ -R1iIE'! 

: 

Gambar 1.2 Contoh jendela layout. 
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Gambar 1.3 Contoh jendela browser. 

Jendelelnfa/Ed,t Cl 
NO_Kontrak: 001/sPKlBP3LG196 

Tgl_Kontrak: 0511711996 

Pekerjaan: Studi Analisis Oampak Lingkungan (AndaQ Sektoral dan Regional 

T gl_ Laporan: 1997 

Pelaksana: Pusat Penelitian Ungkungan Hidup LP-IPB 

Jenis_Pekerjaan: Studi 

NO_Kontrak_ Supervisi: 

Ungkup: PLG 

Gambar 1.4 Contoh jendela info. 

Oakum en Konlrak 13 

T o.mpila.n: 

r.'Yiew 

r Bekcp 

r Edit 

Pekerjo.on: 

Pilih berdo.s~: . 

r Nemer KDntro.k~ 

r Tanggol KOn1rok"·' 

r NamaPekerjoM'. 

r. Pel""'"",, 

QK 

Iulup 

IPemutokhire.n Rencona Rind Jaringe.n Sekunder Oo.eroh Ke~o. B 55.000 He Oi Ko.Iteng 3 

Gambar 1.5 Contoh dialog box. 
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BAB II 
MENGINSTALASI PL SIG 

DATABASE KESEKRETARIATAN PLG 

2.1 Menginstalasi MapInfo 5.5 

Perangkat Lunak Sistem Informasi Geografis (PL SIG) Database Kesekretariatan PLG ini 
dapat dijalankan pada komputer yang sudah diinstall Maplnfo versi 5.5. Berikut ini adalah 
langkah-Iangkah untuk menginstalasi Maplnfo 5.5. 

1. Masukkan CD-ROM Maplnfo 5.5 pada CD-ROM Drive. 

2. Beri perintah Start »Run pada Windows '98 

3. Pada dialog box Run ketik perintah seperti pad a gam bar berikut, kemudian klik OK 
(nama CD-ROM Drive disesuaikan). 

Type the nome'~~I~:~~~~~ resource, and ~ 

Qpen: 

Gambar 2.1 Menginstall Program Maplnfo 5.5. 

4. Jawab semua pertanyaan yang muncul hingga proses instalasi selesai. 

2.2 Menginstalasi PL SIG Database Kesekretariatan PLG 

PL SIG Database Kesekretariatan PLG tersimpan di dalam sebuah CD-ROM. Berikut ini 
adalah langkah-Iangkah untuk menginstalasi perangkat lunak tersebut. 

1. Masukkan CD-ROM yang berisi PL SIG PLG di CD-ROM Drive. 

2. Jalankan Windows Explorer. 

3. Tunjuk direktory PLG pada Drive CD-ROM dan tekan CTRL-C 

4. Tunjuk Drive C dan tekan CTRL-V 

5. Tunggu proses copy hingga selesai. 

6. Beri perintah Start» Run pada Windows '98 

7. Pada diaiog box Run ketik perintah seperti pada gambar berikut, kemudian klik OK 
(nama CD-ROM Drive disesuaikan). 

II -1 
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~ 
~ 

Qpen: 
.. -.,., 

Gambar 2.2 Menjalankan perintah Attrib untuk menghilangkan status ReadOnly pada 
Direktori PLG. . 

8. Buat shortcut untuk PL Database PLG dengan klik kanan mouse » New» Shortcut 
seperti pada gam bar berikut: 

6dNe 

Arronge leons 
Une Up leons 

Refresh 

Eo.ste 
Paste Shortcut 
l.!ndo Delete 

blew -_. 

c §holtcut _ 

I!l Uleadlm' ,ag.'EditOr~~;.g .. :\ .. c: ,':':.,': ",:,,1 

<@ Wave Sound 

reJ Microsoft Po'/"'rf'oil~ f,F >ii, ,se,irtelii6ri:i".: ':1 
f--+-\---;r;"'F7L-,L !J Microsoft Excel Worksheet 

151 Microsoft Office Binder,' " 

I!l Other Office DoCtJm.~.':' 
17$t::==lc::::j:t::.:~ fi Crystal Report 

f--l----+~If 

!ill VlSIO 4 Dmwing 

(llil. Easy CO Creator DOC\lment' ,', 

IIll Jewel Case Creator DotuinenL 

Ilil: Microsoft Dolo. Unk 
=,,~...,.----'I 

Gambar 2.3 Tampilan menu klik-kanan mouse» New» Shortcut. 

9. lsi dialog box dengan C:Ip/glplg.mbx seperti pada gambar berikut, kemudian klik Next: 
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Brows.e.,. . ':. 
"',.." 

Conca! 

Gambar 2.4 Menunjuk file PLG.MBX untuk membuah Shortcut. 

10. Beri nama shortcut dengan Database PLG seperti pada gambar berikut, kemudial) klik 
Finish: . 

Select .. Title for the Program 
. . . _ :f· ~ : ,.':',: :.~:;::: ,~<~.~;ep-f"t..'i::',;' : :~~¢f.~-;i;r",~:::'" '':' -' .. ". "'.:: ,. 

·~e!ed .. name fOr·1Ii.:ihal1cUt:"··~:·, ' 
, __ • ,-foe'.-... , .... ,"""'. • _-'''''r-"'_. __ 

<flO<:!< . • Finish Conca! 

Gambar 2.5 Memberi nama Shouricut dengan Database PLG. 

11. Pad a layar monitor akan tertampil shortcut Database PLG seperti pada gambar berikut: 
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Gambar 2.6 Shortcut Database PLG pada layar monitor. 

Selain dengan di atas dapat juga dibuat shortcut untuk Database PLG pada forider Mapinfo 
yaitu dengan langkah-Iangkah sebagai berikut: 

1. Klik kanan mouse pada menu Slarl (windows) kemudian pilih Open seperti gam bar 
berikut: 

.Q.pen 
" D Explore 

II Dr..:::w arO'.;~e with ACOSee 
Dcxble- Bnd ... 

me st..,.,.,rnS'con....,f~"'~ri'i~;,,~"'~lIT~(s,.,".,.O"'iU,....,.,tv!,./· ~:I.fiit49:8I,g.~i 
Gambar 2.7 Menu Start» Open pada Windows 98. 

:0- S'e/l Menu __ --- . -- -~.~ _____ ~ I 

D 
Start 
Menu 

• '#H-!i·iuf:i 
rl ~ 

New Office Open Office 
Document Document 

''' .• -.>,-.-. 

. .. tfj) 
Undo D 

lID 
Windows 
Update 

Gambar 2.8 Jendela yang muncul setelah Start» Open pada Windows 98. 

2. Klik dua kali pad a folder Programs sehingga tampil jendela folder programs seperti 
gambar berikut: 
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Programs 
r.?,. 
l!llli 

Internet 
Explorer 
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McAfee Microsoft Help 
VirusSco.n Workshop 

Gambar 2.9 Jendela yang muncul setelah dobel-klik pad a Folder Programs. 

3. Klik dua kali pad a folder Mapinfo sehingga tampil jendela icon-icon Mapinfo seperti 
gambar berikut: 

Maplnfo _____ . __ _ ________ _ 

J Ria lOda View !l.o F~rites .·t!~rii'~';", :~',: .;~',::,;. "':': •. , ... :. 

J 
.:? -+ 

~ ISii I X ~ ~ ttl> 
Bo.ck Fory'y'ard Up Cut .. Copy. :Paste Undo 

J Address IB C\W1NOOWS\Sto.rt Menu\Progroms\Moplnfo 

~ e ~ ~ 
rrrm IfJ 

",,0,,, J GPS.MBX I MokeGPS.M ... Mop8osic 5.5 MoplnfoGPS 

Maplnfo I!:!.~er's Guidel User's Guide Software 

..... _.-.. _-

Select an item to ~ ~ ~ ~ 
view its description. Moplnfo Moplnfo OOBCDriver The 

Profession .. : Professiono.l ... Help Geographic ... 

Gambar 2.10 Jendela yang muncul setelah dobel-klik pad a Folder Mapinfo. 

4. Pada jendela tersebut lakukan perintah nomor 8 sid 10 di atas sehingga pada folder 
Mapinfo terdapat incos untuk Database PLG . 

2.3 Cara Menjalankan Perangkat Lunak 

•• Setelah selesai di-install, perangkat lunak ini siap untuk digunakan. Cara manjalankan 
Perangkat Lunak SIG PIJS ini adalah dengan dobel-klik Shortcut Icon Database PLG 
sehingga muncul dialog box untuk login ke PL SIG Database Kesekretariatan PLG seperti 
terlihat pad a Gambar 2.11. 
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Login ke PL SIG Databas ... Ef 

Noma: IAgus 

Pas~rd: 

.QK Iutup 

Gambar 2.11 Login ke PL SIG Database Kesekretariatan PLG. 

• 

• 

• 

'.-~ ...... 
-,' 
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BAB III 
STRUKTUR MENU 

, 

3.1 Tingkatan Menu 

PL SIG Database Kesekretariatan PLG mempunyai tiga tingkatan menu yaitu: 

• Tingkat pertama, PLG 
Tingkatan pertama adalah tingkatan PLG (Pengembangan Lahan Gambut) yang 
menampilkan peta kawasan PLG. Tampilan Perangkat Lunak ini pada tingkatan yang 
pertama dapat dilihat pada Gambar 3.1. Menu Utamanya terdiri dari menu File, Data 
PLG, Laporan, Analisis, Tools, Jendela, dan Keterangan. 

• Tingkat kedua, Daerah Kerja 
Tingkatan kedua adalah tingkatan Daerah Kerja (misalnya Daerah Kerja A) 
Peta yang ditampilkan adalah Peta Daerah Kerja yang bersangkutan. Tampilan pada 
tingkatan ini dapat dilihat pada Gambar 3.2. Menu Utamanya terdiri dari menu File, 
Daerah Kerja ... , Laporan, Analisis, Tools, Jendela, dan Keterangan. 

• Tingkat ketiga, Sub Daerah Kerja 
Tingkatan yang ketiga adalah.tingkatan Sub Daerah Kerja (misalnya untuk DaerahKerja 
A adalah Lamunti, Dadahup, dan Palangkau). Belum semua Daerah Kerja mempunyai 
Sub Daerah Kerja seperti Daerah Kerja E. Tampilan pada tingkatan ini dapat dilihat pad a 
Gambar 3.3. Menu Utamanya terdiri dari menu File, Sub Daerah Kerja ... , Analisis, 
Tools, Jendela, dan Keterangan . 

Gambar 3.1 Tampilan peta pacta Tingkat I: Peta Kawasan PLG. 
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Gambar 3.2 Tampilan peta pada Tirogkat II: Daerah Kerja A. 

• 

• 

. " 

• 

Gambar 3.3 Tampilan peta pada Tingkat III: Sub Daerah Kerja Lamunti. 
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3.2 Menu Utama ' 

Secara umum Menu utama yang ada pada PL Database SIG PLG terdiri dari menu: 

• 
• 
• 
• 
• 
• 
• 

File < 

Data PLG (menu ini selalu berubah sesuai tingkatan daerah kerja yang aktif) 

Laporan (pada tingkat I dan II) 

Info Teknik 

Tools 

Jendela 

Keterangan 

Pad a tampilan di layar, susunan menu utama tersebut seperti terlihat pada Gambar 3.4 
berikut ini. 

""Maplnfo P,ofessional- [Pela PlOyek Pengembangan Lahan Gambul (PLG») 

~ Ble ll"t"PLG l.apo,,," Info Teknik Tllols Jendel .. Ke1erango.n 

~ @.1e.1~1 i IIiiiII ffi:l1~11'iiD1£!j1l 

- )---\I ) ... '" 
Gambar 3.4 Susunan Menu Utama pada PL Database SIG PLG. 

3.2.1 Menu File 

,,-. Maplnfo Professional- [Pera Proyek Pengembangan Lahan Gambul (PLG)] 

~ ll"t"PLG ~apo,,," InfoTeknik TIlOI • .lendel .. 1'9Ie',,"g"" 

~ Ed~ > 
Simpc.n 
J,!pdale > 
Bekap D"I" 
8dmin 

s.etup HoI"",o.n ... 
~loI<... Qrl+P 

I'eluar AIt+F4 

~~------------------~ 
Eassword 
ll .. to.b ... 9 PLG 

Gambar 3.5 Susunan menu File beserta sub menunya. 

Menu file ini ~Gr~~~i,menjadi beberapa sub menu, yaitu: 
• Edit."" '0 0 " '. t .., .. , ..... 

Sub menu ini berfungsi untuk memilih layer yang akan died it. Sila sub lTianU ini 
dipilih maka akan ditampilkan sebuah dialog box yang memungkinkan pengguna 
untuk memilih layer yang akan diedit. 
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Edil label £J 
Piliho.n T o.bel 

QK flo.to! I 
Gambar 3.6 Tampilan Dialog pada pili han File» Edit. 

• Simpan 

Sub menu ini berfungsi untuk menyimpan perubahan-perubahan yang telah 
dibuat. Bila sub menu ini dipilih maka akan ditampilkan sebuah dialog box yang 
mengharuskan pengguna untuk mengisi sebuah password. Bila password-nya 
tidak diketahui maka perubahan-perubahan yang telah dibuat tidak akan dapat 
disimpan. 

Save Table 13 
... :: 

Save Icb!es: 

Password 13 I so.ve. I 
................. -- ... -.. '--:~,'. 

Cancel 
Ketik po.ssword: 

II l:!elp 

QK flo.to! .j 

Gambar 3.7 Tampilan Dialog Password dan Simpan Tabel setelah memilih 
Menu File » Simpan. 

• 

• Update 

Sub menu update ini terbagi menjadi tiga sub. sub menu, yaitu: 

1. Password 

Sub menu ini berfungsi untuk merubah password yang ada. Bila sub menu ini 
dipilih maka akan tampil satu dialog box yang mengharuskan pengguna PL ini • 
untuk memasukkan password lama. Bila password itu benar maka akan 
tampil lagi satu dialog box untuk memasukkan password baru. Pengetikan ,: 
password baru harus dilakukan dua kali pada dialog box terse but. Bila tidak 
ada perbedaan pada dua kali pengetikan password baru, maka password • 
baru terse but akan dicatat. 

2. Database PLG 

Menu ini berfungsi untuk mengupdate data-data yang sudah mengalami 
perubahan. Misalnya user menghapus satu atau beberapa rekord pada 
database. Program masih meninggalkan jejak dari data yang telah dihapus 
tersebut. Untuk menghilangkan jejak tersebut· maka perlu dibuat s~atu 
prosedur update.::~ 

.. ~~: 
. ":'i 
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• Rekap Data 
Sub menu ini berfungsi untuk menampilkan rekapitulasi data yang tersedia pada 
tingkatan menu tertentu. Dengan memilih File » Rekap Data pada tingkat I 
maka akan muncul dialog .box untuk memilih data mana yang akan direkap . 

• Admin 

• 

Sub menu ini hanya ada jika yang login adalah ·Sistem Administrator PL SIG 
Database Kesekretariatan PLG dan berfungsi untukmenentukan siapa saja yang 
berhak sebagai Admin dan Operator, sedangkan untuk User tidak perlu 
ditentukan siapa saja orangnya. Dengan memilih menu File » Admin maka akan 
muncul jendela browser yang berisi daftar pemakai pada tingkat Admin dan 
Operator. 

Setup Halaman 

Sub menu ini berfungsi untuk mensetup halaman, printer dan lain-lain yang 
berhubungan dengan pencetakan (printing). 

Page Setup _ 613 

Kertas 

Ukuran: 

Sumber. IUppertray ~ 

Orientasi Batas I , 

r. PQrtratt 10.25" 10.276" 
I 

Kin: kanan: I 
r Lgndscape Alas: 10.25" Bawah: 10.21 " I 

J 
I Batal '-_----I __ ----l OK /:nriter ... 

Gambar 3.8 Tampilan dialog Setup Halaman. 

- ,', . .-
... .-:' 

/,.~~ . 

~~~y 
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• Cetak 

Berfungsi untuk mencetak gambar yang kita inginkan. Jendela yang akan dicetak • 
secara otomatis adalah jendela layout. Bila tidak ada jendela layout yang terbuka, 
maka jendela yang aktiflah yang akan dicetak. 

QK .6.0.\0.1 

Gambar 3.9 Tampilan dialog pilihan objek yang akan dicetak. 

Print _ 6El 
Printer-----------------------, 

__ Em.....:.,.pe_I1I_·es_....I1 I Noma: 

St~tus: Def~uttprinter. ReQdy 

Tipe: HPLe.serJet~P 

Tempo.t LPT1: 

Comment 

D~rah Cetok---------, Copy----------, 

r P~jjes D~: r- sId r--- Jumlah Copy. ±l 

OK B~ta1 Qptions ... 

Gambar 3.10 Tampilan dialog pencetakan. 

• Keluar 

Berfungsi untuk menutup PL SIG Database Kesekretariatan PLG. 

3.2.2 Menu Data PLG 

Menu ini sebenarnya selalu berubah-ubah sesuai dengan tingkatan daerah kerja. 
Tetapi sub-sub menunya pada semua tingkatan hampir sama. Pada tingkatan 
pertama yang mencakup seluruh Daerah Kerja PLG, sub-menunya seperti terlihat 
pada Gambar 4.11, dan masing-masing dapat dijelaskan sebagai berikut: 
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Yisuo.l 
tlidrologi 

Eet" T emo.tik ... 

O"t"Lo.in 

• • ~------------------------------1 

• 
Kawason Lebih Bind .. 
Peto. Do.20! 

Gambar 3.11 Susunan menu Data PLG dengan sub menunya . 

• Umum 

Sub menu ini berfungsi untuk menampilkan data yang bersifat umum. Sub menu 
ini dibagi lagi menjadi sub-sub menu Sejarah, Struktur Organisasi, dan RUTR 
seperti terlihat pada gam bar berikut ini. 

4' Map\ftlo Professional- [Peta Proyek Petlgembang.... lahoo Gambut{pLG)1 

~ Ble I Q"ta PLG Lo.pomn Info T eknik Tll.ols·· .!endet" lSetero.ngo.n 

r-.;~ !.:!mum ,. 

Yisuol 
tlidrologi 

liejo.rM I 
• Struklur Qrgo.nisClsi 

EetCl T emCltik ... 

OCltClLo.in 

•. BTRW 

• 
Ko.wo.son Lebih Bind .. 
Peto. Do.~O! 

Gambar 3.12 Sub menu Umum terdiri dari Sejarah, Struktur Organisasi, dan 
RUTR. 

Sejarah 

Berfungsi untuk menampilkan infonmasi mengenai sejarah PLG sesuai dengan 
urutan waktu kejadian dan dapat mengakses datalinformasi yang berkaitan 
dengan kejadian terse but, seperti surat dan laporan akhir pekerjaan. Contoh 
tampilan sebagian dan sejarah ini seperti terlihat. pad a gam bar berikut: 
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SEJARAH PEKERJAAN PROYEK PENGEMBANGAN LABAN 
GAMBU1' (PPLG) Dl KALIMANTAN TENGAIl 

26 D«elnl~r 19950:: Pr,siekn RI mendapbn K<:."putu.u.n Pr~iden No. g~ Tolhunl995. 
11:11 P~nl;~hang2in I~han pmooc untuk ~unian u,nlU1t.\1I pan{:2in di io:.:lIunanlan 
T cn,::l1L 

J,lInuari 1996: R<lfI;U koordinasi I RaL:oc) Tim T~kni.. .. ntcnl!ha.~ilklln kcputuun: 
• p¢tnh2n~unan bil..<:«2tnp induk di Kuala Kapua. .. dan 4 suh.ba..;cantJl di O:uhhup. 

Menl2nJ:3i. Jabin.~ dan Bahaur. 
Guh...'1nur Kaltens~~aj \\';'Ikil Kdua II Tim TeknlS. 
P,-~unjuL:L::ln rusal Pengbjian linr,kungatt Uidup IP8 ~cba,l;<1i kon'iultll.n pd:.lks;,tn;c 
sludi AMI)AL 
P~mhangun2njarin~an pec1g1iran sd:.undo!rdi D2tnlh Kclja It.. $I!1u:L." 14~.OOO Ib 
dil;,tlc..~:'lRakan olch. PT Pemhan~unan PdUrruMn d:a:n PT WijW.l Ku),l.. 

-' 
Gambar 3.13 Tampilan sebagian sejarah PLG. 

Struktur Organisasi 

Berfungsi untuk menampilkan struktur organisasi yang ada pada tingkatan 
seluruh daerah kerja PLG. Apabila Organisasi yang ada pad a tingkatan ini 
terdapat lebih dari satu, maka Perangkat Lunak akan menampilkan dialog box 
untuk memilih bagan yang dikehendaki. 

RUTR 

Berfungsi untuk menampilkan data-data RUTR pada suatu tingkatan tertentu. 
Apabila menu ini dipilih maka akan tampil dialog untuk memilih data-data peta 
yang dikehendaki. 

• Visual 

Sub menu ini berfungsi untuk menampilkan data-data vis'ual. Sub menu Visual ini 
dibagi menjadi sub-sub menu Foto, Gambar Desain, Foto Satelit, dan Video. 

""MaplnfD PrDfessiDnal- [Peta P'Dyek Pengembangan Lahan Gambut (PLG)] 

~ file I !late. PLG Lapa,an [nfa Teknik Tllals .!endela l'elerangan 

~~ l.!mum > : 

:Y:lsuel ~ foto 
jjidrolagi > Q,ambcr Desain 

-------- Fotoll.atelL 
Eeta Tematlk __ . 
Datai.ain > 

Kawasan Lebih Bind > 
Peta Da~cr 

Gambar 3.14 Sub menu Visual dengan sub-sub menunya. 
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Gambar 3.15 Salah satu tampilan pada film Parit-parit KeciL 

Peta Tematik 

Sub menu ini menampilkan peta-peta tematik seperti peta Topografi, Kemiringan 
Lahan, Geohidrologi, Genangan Banjir, Ketebalan Gambut, Kedalaman Pirit, dan 
sebaga!nya. Mengingat jumlah data peta tematik yang dapat berubah maka untuk 
melakukan pilihan terhadap data yang dikehendaki disediakan sebuah dialog 
pilihan seperti gambar berikut ini. 

Pela lemalik PLG _ _. _ 1113 
Lookin: I \::iI Tematik 

Elevasi Lehtln 
~Gambut 
~Hidro Topografi 
~ Kesesu"i"n L"h"n 
~Kondisi Tanamtln ASep 
~Pirit 
~ Progres ASep 
~Satuan Lehan 

Filename: 

Files of we: IWorkspace ("'.wor) 

Gambar 3.16 Tampilan dialog untuk memilih peta tematik. 

Qpen 

Cancel 

• Data Lain 

Sub menu ini menampilkan data-data pelengkap yang tidak tercakup pada menu 
lain seperti data-data Dokumen Kontrak, Surahiurat, Risalah-risalah rapat, dan 
data-data investasi. Semua jenis data kecuali data investasi sudah berhasil 
dikumpulkan oleh Konsultan sehingga dapat ditampilkan contoh-contoh dari data 
tersebut. 
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Yisuc.l 
I:!idrologi .~--------------------------~ • 
Eete. T eme.tik ... 
Data!.:e.m • 

Ko.wosan Lebih Bind .­

Pete. 00.>'''' 

Ookumen Konicek 
s.urakuro.t 

Sisal"" Rapo.t 

Gambar 3.17 Sub menu Data Lain dengan sub-sub menunya. 

Oakumen Kantrak . ' 13 

Tampitan: PiHh berd0.8crkon: 

('" Nomor Kontrok 

("' Tonggal Konlrak 

r Noma. Pekerjacn. 

r. Peioksona' 

.QK 

lulup 

Pelaksono. :-------------------_-----

Pekerjo.on: 

I PemutakhirCtn Renco.na Rind Jaringan Sekunder Do.eroh Karja B 55.000 He. Ol Ko.Iteng 

Gambar 3.18 Tampilan dialog untuk Dokumen Kontrak. 

~ Acrobat Reader - [OOl-SPK-BP3LG-96.pdf] !1m 13 m file Ed~ Qocument ~ew 'Mndow'::lielp" 

r~'I~,§I~lro0...I~II~ ~ •• I,."'H:)IDl[jjI~ 
, DEPARTEMEN PEKER.JAAN UMUM 

~ DIREKTORAT JENDERAL PENGAIRAN 

KONTRAK LUMPSUM 

Nomor 
Tanggal 

: 00lfSPKlBP3LGi96 
: 17 MEt 1996 

... 

• 
Gambar 3.19 Contoh View Dokumen Kontrak No. 001/SPKlBP3LG/96. 

111-10 

• 

• 

• 

• 

• 

• • 



• 

.. 

f 

• 

• 

". 

Petunjuk Pengoperasian PL S/G Database Kesekretariatan PLG 

Sural-Sural El 

Tcmpilcn: 

r.~ew 

(" Bekap 

(" Ed~ 

". ". L;';' .. <:.. .: .• 

. Pilih berdasOJken: 

r·.t:iomorSurm 

(" 'r""9901 Surell 

r. Kepodo/Alomell 

(" Eerihol 

(" Q"'; 

Q.K 

Iutup 

Kepod~---------------------------------------------------

Pekerjo.cn: 

I078/S11/97{TJ~ 

Gambar 3.20 Tampilan dialog untuk Surat-surat. 

1'.:: l$robal Reader - [HK-04-04-MN-494.pdf] - ___ BOO 13 

tt!.: .... ~ 
. '\ tIl? 

~ . , 
- . 

t.!Et«.ERl P~~~RJAAN tlMUM 
REPuauK INDONESIA 

No. : Hl\~Q 4. 04-l1I!/4H 
LilI11Jlirnn 

Kepada yang 1erl1Ol\11al 
Oilllk:l!rr PI. Nusamba Agro l,e,tari 
WisMsXaTiMMis lontaiS 

Jakarta, !I Oesember1997 

Gambar 3.21 Contoh View Surat No. HK.04.04-MN/494. 

, 
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Risalah Rapal 13 

Tampilan: 

r.~BW 

r Bekl>p 

r f.dh 

Pilih berdo.sork.on: 

r Tonggol 

('" ~opik 

. r. Pimpinon Rapat 

Jenis Re.pm: 

('" Koardinosi· 

(; TIm Teknis 

r Eokj~ 
('" intern 

('" J..e.irHe.in 

Pimpinon~~t--------------------

Topik: 

IPembaho.son Loporon Tengah Tohun 

Gambar 3.22 Tampilan dialog untuk Risalah Rapat. 

QK 

Iutup I 

~ Acrobat Reader - [01-09-1 99J!.pdl] 1!1913 

L 

RlSALAII RAl"ATl(OORUINASI ~:r: 
TIM TEKNIS Pl!:NCE!\ISANGAN Lo\IrAN GAMBtrr ""'gg." J.", ... ll'~6 

Di Deparfcmen l"tkc:rjaa'n UmllJm 

PtStrla Rapat: 

I. Pimpiold n.pal: M-·_·, p-'. - U ~......... COI"C(]un mum sefaktl l<c(ua Tim Tcknis: 

Hadir' pada_Rft(t~C 
P<l\&<mbangan IAhal! Gambul. 

Men(~.d Pertaniatl. 
S"dalopb.ng ebku W~kil 1(.",. Tim T.~.;" 
p~ Anggota. Tun Teknis dantuao pej.:!Jat)8l1g: mcwakilL 
DJ(ektur Jenderal Pengairanxbku Sekretaci~ Tim 'fcknil:. 

Gambar 3.23 Contoh View Risalah Rakor Tim Teknis Ke I. 

• Kawasan Lebih Rinci 

Sub menu ini berfungsi untuk masuk ke peta kawasan yang lebih kecil. Misalnya 
pada saat ini berada pada tingkatan pertama. Jika ditunjuk Daerah Kerja A 
kemudian memilih menu ini. maka Perangkat Lunak akan menampilkan peta 
Daerah Kerja A. 

• Peta Dasar 

Sub menu ini berfungsi untuk kembali ke peta dasar apabila operator telah 
memilih sub menu lain. Operator dapat --melakukan perpindahan ke tingkatan 
berikutnya setelah menu ini dipilih. Karena pada tampilan ini terdapat batas~n-
batasan daerah yang memungkinkan untuk dipilih. " 
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3.2.3 Menu Laporan 

Menu ini berfungsi untuk menampilkan data-data laporan yang ada pada daerah 
kerja yang bersangkutan (sesuai tingkatan) . 

D.ese.in 
SypeMsi Konstruksi 
~onsuuksi 

Gambar 3.24 Tampilan menu Laporan. 

Menu ini dibagi lagi menjadi beberapa sub menu antara lain: 

• Studi 
Sub menu ini berfungsi untuk menampilkan data kontrakllaporan Studi. 

• Desain 

Sub menu ini berfungsi untuk menampilkan data kontrakllaporan Desain. 

• Supervisi Konstruksi 

• 

Sub menu ini berfungsi untuk menampilkan data kontrakllaporan Supervisi 
Konstruksi. 

Konstruksi 

Sub menu ini berfungsi untuk menampilkan data kontrak pekerjaan Konstruksi 
atau data Laporan Supervisi Konstruksi. 

Lllpa'lIIl Stud; m 
Tampil",,: 

Co Yiew 

r Bekap 

r .E:d~ 

.J •.••.. 
. : .. ' c.,; ... ·,:::'.p.:;·, 

Pilih berd""OIken::,:,;:),,':, Jenis O~t" 

r \!:lomqEI)c>~:,~::::, , ,r. Ringkc1s"" ~or"" 

. r .T""ggolKcnJr1,ii,~//, ' {",Ookumen Kon~o.k 
,:, ',. ,,,,;:'.:: ... C:~L 

qNam'!f;,~'~~l: 
r1'""ggol LeP'cimrf" 

r.:,PeI~""~ QK Iutup 

Pelo.ks",,~ :------~~=.,"""--~-------------,-

Peke~"",,: . ':'"'~""::-'"-"-" 
.'=0: ":'.'-" 
:·t(·~·_ :','. 

I Pembuo.tan Peto. Situasi Detail 1: 5.000 Den Pemotretan Udoro. 1 :20.000 di Do.erah Ke~o. "A" Selu ~ 

Gambar 3.25 Tampilan dialog untuk setelah memilih menu Laporan » Studio 
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~ Acrobat Reader- [03-KONTRAK-BP3LG-97.pdlj I!!I~EI 

RINGKASAN 
Ookumen 
No. Konlrak 
T91. Konlrak 
Pckerjaan 

T91. Laporan 
Pelaksana 

: lap0(3n AJc.hir 
. 031KONTRAKlBP3LGf97 
: 8 Juli 1997 
: PENEUTIAN MAHAJEMEN AIR BAG! BUDIDAYA IKAN 

DALAM RANGKA PENGEMBANGAN LAHAN GAM BUT 
[)( PROP~SI KAUMANTAN TENGAH 
Maret 1998 

: 11M PENELlTIlEMBAGA PENEUTIAN 
U~RsrrASPADJAOJARAN 

PENOAHULUAN 

Gambar 3.26 Contoh tampilan Ringkasan Studi No. 03/KONTRAKlBP3LG/97. 

rg Seagate Crystal Reports for Maplnlo Pro - [Ringkas Report) I!lIiIEI 
1!5 Ble f:dn ~ew Insert F2nnat llatcbas. Bepart Window l:ielp 

Design I Previ...... 10/1~/99 6:57 X H ~ 2012+ 

A 

~ -.~ ~- -r .. ~ >-. N<_ 

" ... <OOIrJlACU··<o.O'M ........ _ ......... "'_ • ..ac:..- ._- ............ _.c.._ 
't"~= 

" Olf(O'I"""ov.!'-JIOVI'" ... ~-~.---......-"'''' ._- ~. ~"-........ _~. ~~ .... -r .... ._- q ~ 

" o:!t<Olo"""qJI')UW'f '~"'"'-'I_/WI'"",~"""OtI.Ifoo ._- ~. u_~ ._- ~'LODl~ 

U Oo5t«)lor1\A«1'kQ'J'I' "' • ...-__ 1:»_~I)I1r'.)<K .... ,.,......r.-~ ,,-- 1._ANoId_ IS"", tK~:K .. 
_ ... _-

.. Oi("I'f""QII,(1I'1'f!K upotMI....,.. ..... ~ --.- -- rr_w_~ 

»OI<_WIH. ~ UNo< --. I AU .... P ""-t 

" 04t<0II","(l1'J.cQW llllCootIIIOoIfI"- IIYNI_NirCH ....... lO ._- ~ 
t'I't.II,. ... ___ ... 

U At~"" tp;'f .... c.c-~ 'IOP ue-t 

.. ~~~"""II'- ~~~:~Mf""""P ._- .,..::-.. ~-,,- ~J 

Gambar 3.27 Tampilan Rekap Ringkasan Laporan. 

~ Ringkas Browser I!!II!I EJ 
ITgI Kontrak IPekerjaan 

05/KONTRAKlBP3LG197 14 Agustus 1997 Uji Coba Dan Pemant· 

02/KONTRAKlBP3LG197 B Juli 1997 Uji Coba Dan Pemant, 

03/KONTRAKIBP3LG197 B Juli 1997 Penelttian Manajemen 

OB/KONTRAKlBP3LG197 2 September 1997 Proyek Penelitian Apli 

13/KONTRAKlBP3LG197 14 Nopember 1997 Pemantauan Pelaksar 

09/SPKlBP3·LG/1995 9 Desember 1995 Identifikasi Peningkat, 

OOB/SPKlBP3-LG195 12 Agustus 1996 Supervisi Konstruksi J 

n /KONTRAKlRP::l1 8197 ? .htli Hl~7 RllnRrvi~i Knn~tnlk~i. 

Gambar 3.28 Tampilan Browser Edit Ringkasan Laporan 
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3.2.4 Menu Info Teknik 

Menu ini berfungsi untuk menyajikan informasi teknis mengenai perkembangan 
Proyek Lahan Gambut dalam bentuk laporan. Laporan mengenai PLG yang 
dltampilkan berupa evaluasi dan rekomendasi tindak lanjut pada suatu daerah 

.. tertentu sesuai tingkatannya, gagasan pengembangan dan evaluasi dan 
rekomendasi tata air pada suatu kawasan PLG tertentu. 

3.2.5 Menu Tools 

Menu ini berfungsi sebagai alat bagi pengguna Perangkat Lunak ini dalam 
berinteraksi atau bekarja dengan peta yang ditampilkan. Menu Tool ini mempunyai 
beberapa sub menu yaitu: 

~ Iuniuk Or!+A 
-=~~~:!..I..- Perl!eso.rTe.mpiion Or!+B 

Per!sealTe.mpilon Or!+S 
,aaser Ctrf+R 
Info Or!+a 

Gambar 3.29 Tampilan Menu Tools . 

• Tunjuk 

• 

• 

• 

Sub menu ini berfungsi untuk menunjuk objek yang ada pad a peta yang 
ditampilkan. Berfungsinya sub menu ini ditandai dengan pointer pada jendela 
peta yang berbentuk sebuah panah. 

Perbesar Tampilan 

Sub menu ini berfungsi untuk memperbesar tampilan peta (zoom). Bila sub menu 
ini dipilih maka pointer pada jendela peta akan berbentuk sebuah kaca pembesar 
atau suryakanta dengan tanda positif (+) di tengahnya. Dengan pointer ini 
pengguna dapat memperbesar daerah-daerah pada peta sesuai dengan yang 
diinginkan 

Perkecil Tampilan 

Sub menu ini berfungsi untuk memperkecil tampilan peta. Bila sub menu ini dipilih 
maka pointer pada jendela peta akan berbentuk sebuah kaca pembesar atau 
suryakanta dengan tanda negatif (-) di tengahnya. Dengan sub menu ini 
pengguna dapat memperkecil tampilan peta pada jendela peta. 

Geser 

Karena layar komputer sangat terbatas sehinga tidak dapat menampilkan semua 
objek yang ada pada peta pad a suatu skala tertentu, maka perlu suatu alat (tool) 
untuk menggeser peta pada jendela peta ter:ebut. Sub menu inilah yang dapat 
digunakan untuk menggeser peta pada jendelapeta. Bila sub menu ini aktif maka 
pointer pad a jendela peta akan berbentuk sebuah telapak tang an. 
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• Info 

.\ 

Sub menu ini berfungsi untuk menampilkan sebuah jendela info yang berisi 
informasi-informasi yang. berkaitan dengan objek yang dipilih. Aktifnya sub menu 
ini ditandai dengan berubahnya pointer pada jendela peta menjadi berbentuk 
sebuah crosshair (dua buah garis pendek, vertikal dan horisontal, yang 
berpotongan tegak lurus). Untuk mengetahui informasi yang ada pada sebuah • 
objek, cross hair tersebut harus di-klik pada objek yang dimaksud. 

• Toolbars 

Perangkat Lunak Database SIG PLG ini dilengkapi dengan sebuah Tool Bar 
untuk memudahkan pengguna untuk memberikan perintah tanpa melalui menu 
yang ada. Untuk membuka atau menutup Tool Bar tersebut dapat digunakan sub 
menu ini. 

Toolbar Options 13 

Ioolbar Show Aoating 

MenuTombol "I-I _O_K---, 
Ed~Garnbar 

6.atal 

W CnlorButtons r Large Buttons "w ShowToomps 

r SCM! as Qat""lt 

Gambar 3.30 Tampilan dialog setelah memilih menu Tools » ToolBars. 

3.2.6 Menu Jendela 

Menu ini secara garis besar berfungsi untuk rnembuka ataupun menutup jendela­
jendela yang ada pada PL Database SIG PLG ini. Susunan menu Jendela dapat 
dilihat pad a Gambar 3.31. 

Gambar 3.31 Tampilar Menu Jendela. 

Jandala 

Buka6.rowser 
BukaLaYout 

Pada Gambar 3.31 menu Jendela terdiri dari beberapa sub menu yaitu: " 
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• Buka Browser 
Sub menu ini berfungsi untuk menampilkan (membuka) jendela browser. Bila sub 
menu ini dipilih. akan tampil sebuah dialog box yang berfungsi untuk memilih 
jenis browser yang akan ditampilkan. Jendela browser ini hanya dapat 

, ditampilkan satu jenis saja. Bila pengguna membuka jendela browser jenis lain 
• maka jendela browser yang lama akan otomatis tertutup. 

Contoh tampilan browser dapat dilihat pada Gambar 3.32. 

Gambar 3.32 Contoh Tampilan Browser. 

• Buka Layout 

Sub menu ini berfungsiuntuk menampilkan (mernbuka) jendela layout i.mtuk 
keperluan pencetakan (printing) ataupuh menutupnya. Dengan jendela layout ini 
kita dapat mengatur jendela apa saja yang akan dicetak dan juga dapat 

y mengatur posisi jendelayang akan dicetak tersebut pad a kertas. 

• 

• 

. , 

Contoh tampilan Layout dapat dilihafpada Gambar 3.33 . 

Fl; Layout I!!I~ D 
... 

... 
• 

Gambar 3.33 Contoh tampilan Layout pencetakan. 

• Frame 

Sub menu ini berfungsi mengisi jendela layout dengan gambar-gambar yang 
akan dicetak (jendela-jendela yang aktif). Bila sub menu ini dipilih maka akan 
tampil sebuah dialog box untuk memilih jendela apa saja yang akan dimasukkan 
ke dalam jendela layout. 
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Sub menu ini aktif hanya jika ada jendela layout yang terbuka. TampilanDialog 
Box yang keluar setelah dipilih menu Frame seperti terlihat pada Gambar 3.34. 

Membual Frame £I 
Pilihan Obyek 

QK !lata! 

Gambar 3.34 Contoh tampilan Dialog Box untuk memilih Frame. 

• Sebar (Tile) 

Sub menu ini berfungsi untuk mengatur tata letak jendela yang ada pada layar 
monitor. Pada beberapa perangkat lunak yang ada di pasaran, menu ini sama 
dengan pilihan menu Window 0+ Tile. 

• Tumpuk (Cascade) 

Sub-menu ini berfungsi untuk mengatur tatc! letak jendela yang ada pad a layar 
monitor. Pada beberapa perangkat lunak yang ada di pasaran, menu ini sama 
dengan pilihan menu Window 0+ Cascade. 

3.2.7 Menu Keterangan 
Menu ini terdiri dari dua sub menu yaitu: 

• Petunjuk Pengoprasian 

Sub menu ini berisi tentang petunjuk pengoperasian yang dike mas seperti 
program help pada program-program yang berbasiskan sistem operasi windows 
secara umum. 

Contoh Tampilan dari Program bantu ini dapat dilihat pad a Gambar 3.35. 

111-18 

• 

• 

• 



• 

. .,., . 

• 

• 

. , 

Petunjuk Pengoperasian PL SIG Database Kesekretarfatan PLG 

Help Topics: Petunjuk Pengoperasian PL SIG Database Kesekretariatan ..• Ii EI 
Contents I Find I 

Oick a topi(! end then dick Oisploy. Or dick anothertob. such o.slndex. 

? Pendohuluo.n 
111 .. ~~".'angkat Lunak 
111", 
111 

QisplO¥ I. Eliol... Cancel 

Gambar 3.35 Contoh tampilan menu keterangan . 

• Info Singkat 

Berisi info singkat tentang Perangkat Lunak Database SIG PLG. 

Tenlang PL Database SIG PLG EJ 
Parangkat lonak SIG Databasa Kasekretari"tan PLG 

Proyek Pangamb"ngan Lahan Gambut 

Propinsi Kclimo.nto.n T engon 

T aIlun Anggaran 1999/2000 

Oisusun oleh: PT. Horimada Bime.rakso. 

Ii OK I 

... '. ... 

Gambar 3.36 Tampilan Info Singkat PL SIG Database Kesekretariatan PLG. 

3.3 Menu Tambahan 

Selain menu-menu yang telah dijelaskan diatas, Perangkat Lunak ini memiliki 
beberapa menu tambahan yang mempunyaifungsi tertentu pula. Adapun menu 
tambahan yang ada pada Perangkat i:.unak ini antara lain: 
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3.3.1 Menu Shortcut Peta 

Untuk menampilkan menu shortcut peta ini pengguna harus menekan tombol • 
sebelah kanan pada mouse (klik·kanan) ketika pointer berada di jendela peta. Pad a 
PL ini tampilan menu shortcut peta bermacam-macam sesuai dengan objek yang 

, ditunjuk dan tingkatan penggunanya. 

Gambar 3.37 Contoh tampilan menu Shortcut pada jendela peta. 

!,eyerPeta 
f!o.teJ 

tiapus 
l:;opy 

Orl+Z 

o.rJ+X 
CIrI+C 

anN 

Gambar 3.38 Tampilan menu Shortcut pada jendela peta setelah memilih saluran. 

3.3.2 Menu Shortcut Layout 

Untuk menampilkan menu shortcut layout ini, pengguna harus menekan tombol 
sebelah kanan (klik-kanan) mouse, ketika pointer berada di jendela layout. 

Sub-sub menu yang terdapat pada menu ini yaitu: 

o Ubah tampilan 

• 

• 

• 

• 

Sub menu ini berfungsi untuk mengubah skala tampilan pada jendela layout. Bila ' 
sub menu ini dipilih maka akan muncul satu dialog box untuk menentukan skala 
tampilan yang diinginkan (%). 

o Tampilan Aktual 

Sub menu ini berfungsi untuk mengatur tampilan pad a jendela layout sehingga 
tampilan tersebut mempunyai skala 100%. 

o Tampilan Penuh 

Sub menu ini beiiungsi untuk mengatur tampilan pada jendela layout sehi~gga 
semua objek yang berada di jendela layout tersebut dapat terlihat. .;: 

'.' 
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• Tampilan Sebelumnya 

Sub menu ini berfungsi untuk mengembalikan tampilan di jendela layout seperti 
tampilan sebelumnya. 

< 

Contoh tampilan menu Shortcut Layout dapat dilihat pada Gambar 3.39 . 

!.!boh T o.mpilan 
IampilanAktuoJ 
TampilanE.enuh 
Tampilan Sebelumnyo 

Gambar 3.39 Contoh tampilan menu Shourtcut pada jendela layout. 

3.3.3 Menu Tombol (Tool Bar) 

Menu tombol adalah Tool Bar yang terletak dibawah menu bar utama iJada layar. 
Menu Tombol ini berfungsi untuk memudahkan pengguna dalam bekerja dengan 
Perangkat Lunak Database SIG PLG ini. Dengan tersedianya tool bar ini, untuk 
perintah-perintah tertentu, pengguna tidak perlu melakukannya melalui menu tetapi 
cukup melalui tool bar ini. 

Menu Tombol ini dapat dilihat pada Gambar 3.40. 

Gambar 3.40 Susunan icons pada menu tombol. 

Menu tombol terdiri dari beberapa bagian yaitu: 

• Tunjuk 

Bagian ini mempunyal Icon bergambar tanda panah yang berfungsi untuk 
memilih atau menunjuk objek-objek yang diinginkan. 

• Perbesar 

Bagian ini mempunyai icon bergambar suryakanta dengan tanda positif (+) di 
tengahnya. Berfungsi untuk memperbesar tampilan peta pada jendela peta. 

• Perkecil 

Bagian ini mempunyai icon bergambar suryakanta dengan tanda negatif (-) di 
tengahnya. Berfungsi untuk memperkecil tampilan peta pada jendela peta. 

111-21 



Petunjuk Pengoperas;an PL SIG Database Kesekretariatan- PLG 

• Geser 
Bagian In! mempunyal Icon bergambar sebuah telapak tangan dan berfungsi • 
untuk menggeser peta pada jendela peta. 

• Info • 
Bagian ini mempunyai icon bergambar huruf i dan berfungsi untuk menampilkan 
sebuah jendela info yang berisi informasi-informasi penting berkaitan dengan. .­
objek yang dipilih. .. 

• Browser Tabel 

Bagian ini mempunyai icon bergambar sebuah tabel yang melambangkan sebuah 
browser. Fungsi bag ian ini adalah menampilkan jendela browser. Sebeum 
menampilkan jendela browser, pengguna harus memilih dulu jenis browser apa 
yang akan ditampilkan melalui sebuah dialog box yang tampil bila bagian ini 
dipilih I diaktifkan. 

• Layout 

Bagian ini mempunyai icon bergambar sebuah jendela layout dan berfungsi untuk 
menampilkan sebuah jendela layout yang diperlukan untuk keperluan 
pencetakan. -

• Frame 

Bagian ini berfungsi untuk mengisi jendela layout dengan gambar-gambar yang 
akan dicetak Gendela-jendela yang aktif). Bila bag ian ini dipilh maka akan tam pi I • 
seb-uah dialog "box"untuk memilih jendela apa saja yang akan dimasukkan ke 
dalam jendela layout. 

• Simpan 

Bagian ini berfungsi untuk menyimpan data yang sudah mengalami perubahan 
seperti halnya pad a menu File » Simpan. Jika bagian ini dipilih maka akan 
keluar dialog password yang kemudian muncul dialog untuk memilih tabel mana 
yang akan disimpan jika pada saat itu terdapat satu atau lebih tabel yang perlu 
disimpan. 

• Cetak 

Bagian ini berfungsi untuk mencetak. Bila ada jendela layout yang aktif, secara 
otomatis jendela itulah yang akan dicetak. Tapi bila tidak ada jendela layout yang • 
aktif maka jendela peta yang aktif lah yang akan dicetak. 

3.3.4 ToolBar Edit 

ToolBar Edit ini berguna dalam proses peng-editan gambar atau peta. ToolBar Edit 
Ini mempunyai beberapa bag ian yaitu: 

• 
• 
• 

Simbol, berfungsi untuk membuat simbol pad a jendela peta 

Garis, berfungsi untuk membuat garis lurus pada jendela peta 

Polyline, berfungsi untuk membuat garis dengan banyak node 

• Arc, berfungsi lJntuk membuat garis lengkung 

• Po ligon, berfungsi untuk membuat daerah segi banyak tak beraturan ;; 

• Ellips, berfungsi untuk membuat ellips 
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• Segiempat, berfungsi untuk membuat daerah dengan bentuk segi empat 

• Segiempat bulat, berfungsi untuk membuat daerah berbentuk segi empat yang 
sudut-sudutnya dibulatkan 

" Teks, berfungsi untuk membuat teks 

• • Reshape, menampilkan node-node yang ada pada suatu objek polyline atau 
objek polygon 

• Node, berfungsi untuk menambah node pad a polyline atau polygon 

• Layer, berfungsi untuk mengatur tampilan layer 

• Style Symbol, berfungsi untuk mengatur jenis simbol 

• Style Garis, berfungsi untuk mengatur jenis garis 

• Style Area, berfungsi untuk mengatur jenis polygon 

• Style Font, berfungsi untuk mengatur jenis huruf 

• Gabung, berfungsi untuk menggabung dua objek atau lebih menjadi satu objek 

• Ke Region, berfungsi untuk mengubah objek polyline menjadi region 

• Ke Pline, berfungsi untuk mengubah objek region menjadi polyline. 

Tool Bar Edit Gambar dapat dilihat pada Gambar 3.41. 

Gambar 3.41 Ganibar menu ToolBar Edit. 

• 

• 

• 
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4.1 Umum 

BAB IV 
EDITING 

Pad a level Admin dan Operator. Perangkat Lunak SIG Database Kesekretariatan PLG 
memberikan beberapa fasilitas untuk melakukan perubahan-perubahan pada gam bar 
ataupun data-data yang ada di dalamnya. Sedangkan pada level User. fasilitas tersebut tidak 
disediakan. 
Fasilitas-fasilitas yang ada untuk melakukan perubahan-perubahan tersebut dibedakan 
menjadi empat macam antara lain: 
1. Mengedit data dengan jendela Browser dan Info 
2. Mengedit obyek gambar/peta dengan menggunakan sub menu Edit » Layer Peta pada 

menu File dan juga sub menu update pada menu file. 
3. Mengedit data dengan Perangkat Lunak Penunjangseperti Microsoft Excel. 
4. Mengupdate Password dan Database PLG. 

, 4.2 Mengedit Data dengan lendela Browser dan lendela Info 

Untuk database yang menyimpan data" alfanumerik, cara me·ngeditnya dapat dilakukan 
• dengan menggunakan jendela browser maupun jendela info. Pad a jendela browser field-field 

data tersusun menyamping, sedangkan pada jendela info datanya tersusun ke bawah. 
Contoh berikut adalah langkah-Iangkah untuk mengedit data Laporan Studi dengan jendela 
browser: . 

1. Pilih menu Laporan » Studi 

2. Pada tampilan dialog Laporan Studi, pilih Edit dan klik OK 
3. Tunjuk rekord dan field yang akan diedit sepertIpada Gambar 4.1. 
4. Lakukan edit sehingga hasilnya seperti terlihat pada Gambar 4.2. 

• 

• 

Gambar 4.1 Tampilan jendela browser sebelum diedit. 

IV-1 



Petunjuk Pengoperasian PL SIG Database Kesekretariatan PLG 

Gambar 4.2 Tampilan jendela browser setelah died it. 

Contoh berikut adalah langkah-Iangkah untuk mengedit data Laporan Studi dengan jendela 
info: 
1. Pilih menu Laporan » Studi 
2. Pada tampilan dialog Laporan Studi, pilih Edit dan klik OK sehingga tampil jendela 

browser 
3. Pilih menu Tools » Info atau Klik toolbar Info (tombol tool bar berbentuk huruf i) pada 

menu tombol 
4. Klik pada rekord yang akan diedit sehingga tampil jendela info berserta field-field datanya 
5. Tunjuk field yang akan diedit seperti pada Gambar 4.3. 
6. Lakukan edit sehingga hasilnya seperti teriihat.pada Gambar 4.4. 

Jendele Inlo/Edlt _ Cl 
. No_Kontrak: 00IISPKlBP3LGI96 

TgLKontrak: 05117/1996 

Pekerjaan: 3tudr Anahsrs Dam ak LmQ~ un(lM SeHcI,al dan ReQlonal 

T gL laporan: 1997 

Pelaksana: Pusat Penelitian lingkungan Hidup LP-IPB 

Jenis_Peketiaan: Studi 

No _ Kontrak_ Supervisi: 

Gambar 4.3 Tampilan jendela info sebelum diedit. 

Ustudi ~ 

Jendele Info/Edit £l 
No_Kontrak: 00IISPKlBP3LGI96 

TgLKontrak: 05/17/1996 

Pekedaan: 3tudr Anahsis Dam ak LmQ).,unQan (Anda!l SeHoral dan ReClrona! 

Tgl_Laporan: 1997 

Pelaksana: Pusat Penelitian Lingkungan Hidup LP-IP8 

Jenis_Pekerjaan: Studi 

No _Kontrak _ Supervisi: 

Gambar 4.4 Tampilan jendela info setelah diedit. 

Ustudi ~ 
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4.3 Mengedit Objek Gambar/Peta 

Objek-objek gam bar seperti saluran, bangunan air, dan lain-lain yang ada pada perangkat 
lunak ini dapat juga diedit, seperti memindah posisi, mengubah panjang saluran, menambah 
data dan :;;ebagainya. . . 

o. Berikut ini langkah-Iangkah untuk mengedit objek gam bar: 
1. Pilih menu File» Edit» Layer Peta 

.• 2. Pada tampilan dialog Edit Layer Peta pilih layer yang akan diedit misalnya Hidrologi 
kemu.dian klik OK. Pada saat ini layer Hidrologi sudah editable. 

• 

3. Lakukan edit pad a salah satu objek data Hidrologi misalnya dengan menggeserl 
memindah lokasi dari stasiun klimatologi Sampit. 

T g. Malatayur 

Jj3JIT 

Gambar 4.5 Lokasi stasiun klimatologi Sampit sebelum died it. 

T g. Malatayur 

• Gambar 4.6 Lokasi stasiun klimatologi Sam pit setelah died it. 

4.4 Mengedit Data dengan Perangkat Lunak Penunjang 

Database PLG mempergunakan beberapa perangkat lunak penunjang dalam menampilkan 
data. Perangkat lunak penunjang tersebut adalah Microsoft Word, Microsoft Excel dan 
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Adobe Acrobate Reader. Pengeditan data pada perangkat lunak penunjang mengikuti sistem 
operasi masing-masing perangkat lunak . 

Pada buku Petunjuk Pengoperasian ini tidak dibahas pengeditan data pada perangkat lunak 
penunj~ng dengan menganggap· bahwa sistem pengoperasian terse but sudah umum 
digunakan dan pengguna sudah biasa menggunakan sistem operasi perangkat lunak 
penunjang tersebut. Data Hidrologi merupakan suatu kekecualian, hal ini dikarenakan pad a , 
data Hidrologi ditambahkan aplikasi Macro yang merupakan bagian dari sistem 
pengoperasian Microsoft Excel. Bagi pengguna yang sudah terbiasa mempergunakan 

) 

Microsoft Excel dengan Macro pengeditan data Hidrologi bukanlah suatu hal yang sukar 
karena menggunakan sistem pengoperasian Microsoft Excel, danfonnat yang disajikan pun 
dibuat untuk memudahkan pengguna disertai keterangan-keterangan. Data Hidrologi ini 
disajikan dalam bentuk tabel dan grafik. 

Pengeditan Data Hidrologi akan diuraikan secara khusus pada subbab ini dengan 
mengambil contoh pada Data Tinggi Muka Air. 

Pada Gambar 4.7 ditunjukkan tampilan Data Tinggi Muka Air di lokasi L 1 - SPU4 (Sungai 
Mangkatip - Anjir L). 

. Data Tinggi ?vluka Air 
-

. - D. - SPUzr---~-~ - -
SWlgai Balito - AlIjn-L--

D:lJam Bentuk I Oalam Bentuk 
-TABEL I GRAFIK 

JAN 1 FEB 1 ~ ~ 
~ ~ ~ APR 1 
~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ RESUME I 

Simpan 

Keluar· Alt + F4 ~f1 I 
I 

__ '1.. .... __ 

Gambar 4.7 Tampilan Data Hidrologi Tinggi Muka Air. 

Data Hidrologi Tinggi Muka Air disajikan dalam bentuk tabel dan grafik. Tombol-tombol yang 
ada mengacu pada data yang akan ditampilkan. Dengan menekan tombol Jan pada kolom 
Dalam Bentuk Tabel akan terlihat tampilan seperti pada Gambar 4.8 berikut ini. 
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t) Kemban cetak DATA TINGGI MUKA AIR INTERV 
l;;n T ... mb ... h " Simpan o ... t.a Lokasi: L1 - SPU4 (Sungai Barito - Anjir L) 
I~ 

Bulan: Januari 
I~ -" :!O 

'5' 
Tanggal Waktu 1997 1998 

~ 16: 00 5.09 ~ 
17: 00 5.25 

-" IQ 18: 00 5.34 
3 19: 00 5.40 ~ 

lei 20: 00 5.40 
Q. 21 : 00 5.38 
~ 

22:00 5.36 l!i 23: 00 5.36 .. 
10 Januari 00: 00 5.34 

I';; 01 : 00 5.33 => 
"-- 02: 00 5.32 0 
:!O 

n~- nn ~ :n 
Gambar 4.8 Tampilan DataTinggi Muka Air pada bulan Januari. 

Data Tinggi Muka Air yang ditampilkan menyangkut waktu dan tinggi muka air dengan 
interval waktu 1 jam. Pengeditan data dilakukan dengan sistem pengoperasian Microsoft 
Excel.· 

Pada Gambar4.8·diatas terdapat beberapa tomboi Macro yang memiliki fungsi sebagai 
berikut: 

• Tombol KEMBALI berfungsi untuk kembali pad a menu tampilan sebelumnya (Tampilan 
Menu Utama Gambar 4.7) 

• Tombol SIMPAN berfungsi untuk menyimpan data 

• Tombol CETAK berfungsi untuk mencetak data 

• Tombol TAM BAH DATA berfungsi untuk menambah data selama 1 (satu) tahun 

Apabila tombol TAMBAH DATA ditekan akan muncul dialog seperti berikut ini. 

: 00 
: 00 
: 00 
: 00 
: 00 
: 00 
: 00 
: 00 
:00 

5.40 
5.40 

Microsoft EHcel E3 

T ampilan dalam Bentuk Grafik dilakukan Secara Manual 

Gambar 4.9 Dialog pesan untuk tam bah data. 
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Dialog tersebut mengingatkan kepada operator untuk membuat data Tinggi Muka Air dalam 
bentuk grafik secara manual berdasarkan masukan data. Pembuatan data dalam bentuk 
grafik akan disajikan pada subbab ini. 

Apabila{ pad a dialog tersebut ditekan tombol OK atau menekan tombol ESCAPE· pada 
keyboard maka akan muncul dialog selanjutnya (Gam bar 4.10) untuk konfirmasi persetujuan 
tam bah data. Apabila tombol OK ditekan maka akan muncul ruang untuk mengisi data Tinggi ' 
Muka Air pada tahun selanjutnya (Gambar 4.11). . 

5.40 
~ 4n 

:00 
:00 
: 00 
: 00 
:00 
: 00 
:00 
: 00 
: 00 

TambahDala. . DEJ 

Conce! 

5.33 

Gambar 4.10 Dialog konfirmasi untuk tam bah data. 

Bulan: Januari 

- Tanggal- Waktu 1997 1998 1999 
I 

1 Januari 00:00 
01: 00 
02: 00 
03: 00 
n" . nn 

Kolom 
tambahan 

/ 
data 

Gambar 4.11 Tampilan data tinggi muka air dengan menekan tombol TAM BAH DATA. 

Pengisian data tinggi muka air dilakukan dengan sistem pengoperasian Microsoft Excel pada 
ruang yang telah disediakan. 

Pembuatan data baru dalam bentuk grafik dUakukan dengan mengikuti langkah-Iangkah 
berikut ini: 

1. Copy grafik sesuai dengan data yang ditambahkan (misalnya apabila ditambahkan data 
pada bulan Januari, maka grafik bulan Januari di-copy. 

2. Paste grafik tersebut pada sheet yang sama 

3. Format sumber data (Source Data) dengan memasukkan nUai sumbu X dan sumbu Y 
sesuai dengan data yang akan dimasukkan 

• Sumbu Y merupakan nUai data tinggi muka air·yang dimasukkan 

• Sumbu X merupakan waktu pengamatan (tanggal) sesuai dengan data tinggi muka 
air. Pihak Konsultan telah membuat tanggalan selama tahun 1997 - 1998 yang dapat 
dipergunakan untuk masukan data nilai Sumbu X pada Sheet SUMBU X. 

4. Ubah judul grafik sesuai denf!an data yang dimasukkan. 
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